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1. Introduction
Geographic Information System (GIS) is a useful tool for preparing, managing, analyzing and
presenting spatial data. Furthermore, in this era of open science, ample open access data is

available that can easily be retrieved and integrated in open source desktop GIS software, such
as Quantum GIS (QGIS).

In this exercise, you will be guided through steps of working with spatial data models including,
vector and raster data models. Vector data models represents real world features using points,
lines and polygons. Examples of vectors include boreholes and populated places as points, roads
and waterways as lines and administrative areas (counties, countries etc.) as polygons.

Raster data models represent real world features in the form of equally sized grid cells arranged
in rows and columns with each cell containing an attribute value. They are ideal for continuous
data such as elevation and precipitation (Shekhar et al., 1997).

Apart from introducing spatial data models, the module will introduce the learner to basic spatial
analysis methods and simple map design in QGIS software. This is meant to be a gently
introduction to GIS.

Task Description

The main task in this assignment is to carry out preliminary assessment of access to water
(boreholes) in sub-locations in the north of Isiolo County, Kenya. A user of this module should
understand that this is only a hypothetical case whose sole purpose is to introduce steps in
geospatial data handling, analysis and visualization.

Data

In order to achieve the desired objective which is preliminary assessment of assess to water
(boreholes) in Northern parts of Isiolo County in Kenya, we will use different datasets. This
includes Vector data files such as Area of Study boundary, Populated places, Boreholes location
data, and Sub locations boundaries. In addition, we will use Raster data such as Elevation,
Distance to waterways, Population and Land cover. The first step is to download the datasets
which can be accessed here (https://tinyurl.com/yxnmz4fm). The data is divided into three
subfolders which are Raster, Vector and Tabular. Once downloaded, save the data in a Folder
easily assessable as required during subsequent operations.

1.1 Learning Objectives
Upon successful completion of this step by step tutorial, the learner should be able to:
e Add tabular, vector and raster data onto a GIS software and carry out preliminary data
preparation.
e Carry out simple spatial data analysis in QGIS using both vector and raster data models
e Create a simple map in QGIS map composer.
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2. Getting familiar with QGIS

2.1 Install QGIS

In case you have not installed QGIS software in your computer, an installation file can be
downloaded from here https://qgis.org/en/site/forusers/download.html

2.2 Start QGIS

6. Open Different
Types of GIS Data
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1. Table of Contents

4. Map Canvas
(Layers) (blank right now)
T T Ready Coordinate[-1.582,0.985 ® Scale[1:1137306 ~] @ Maonfer[100% =] Rotaton [0.0° P render 2scs @

7. On-The-fly (OTF)

Projection

The QGIS main window is made of the Standard System Menu or Main Menu (we will refer to
Main Menu in the following pages) which is always on the top of the software's window, and
contains standard toolbars like the Zoom, Pan, Select Tools, or others that can be activated
clicking in the Main Menu View and then Toolbars.

On the left hand side there is the Table of Content (Layers list) area. This is where the names of
the data or layers that are added onto the software will be displayed. To the left of this space,
there is a vertical toolbar, the Manage Layers toolbar.

In the center of the window is the Map Canvas, where all maps will be displayed. More
information about the QGIS Graphical User Interface can be found here:
http://docs.qgis.org/2.18/en/docs/user _manual/introduction/qgis _gui.html
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3. Vector data analysis
Commonly, we can originally have geographic data (coordinates and place names) in tabular files
like Microsoft Excel or Comma Separated Values (CSV). This part of the tutorial demonstrates the
steps of converting tabular data into spatial data models and how to display them in standard
GIS software.

Originally, data on places in the study area are in a table with names, geographic coordinates and
other attributes. We have to import the table into QGIS and convert the tabular data to a point
data model. A common file format for storing vector data models in GIS is called Shapefiles. So
in this case the tabular data will be converted to point shapefiles.

It is particularly recommended that your tabular data should either be in CSV format or in a tab
delimited text file.

Code | Name Latitude | Longitude | Classl | Class2 Country
1 | Bulesa 1.00273 38.54686 | Place Populated Place | Kenya
2 | Gafarsa 0.94054 38.59475 | Place Populated Place | Kenya
3 | Malka Galla 1.20097 38.89144 | Place Populated Place | Kenya
4 | Merti 1.06725 38.6662 | Place Populated Place | Kenya
5 | Sericho 1.14495 39.08681 | Place Populated Place | Kenya

Our tabular data contains 5 features (points). Each point has 7 attributes include code, place
name, geographic coordinates (Latitude and Longitude), class (Class1 and Class2) and country.
Geographic coordinates are important as they help us to place our points at specific location on
earth. Other attributes are also important, as they tell us more (describe) geographic data.

3.1 Import tabular data into the map
In this example, we are going to import a table, containing place names and their corresponding
geographic coordinates into QGIS software. The table is named Populated places.csv. The format is
comma separated values (CSV).

e On the main menu click Layer > Add Layer > Add Delimited Text Layer
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(2 *Untitled Project - QGIS

Project Edit View JEWEd Settings Plugins Vector Raster Database Web Mesh SCP Processing Help

0O % 0 Data Source Manager Ctrl+L o~ - - ~ O Y= [T
Create Layer — .
TR = aoe s
A \f; Add Vector Layer... Ctrl+Shift+V
WLEC mbed Layers and Groups... aster Layer... trl+Shift+ 2 -
P oBEER .. d6 B!, Add Raster L Coteshifter (20017 B e
Browser - .
Add from Layer Definition File... Add Mesh Layer...
iETEe ’ AllDl T L.
C Styl dd Delimited Text Layer...
r I-j Data opy Syl - 2 .
v 7 QIS Training Paste Style 'ﬂ Add PostGIS Layers... Ctrl+Shift+D
» [ Rasters Copy Layer ﬁ: Add SpatialLite Layer... Ctrl+Shift+L
» 5 Vector Paste Layer/Group DB Add MSSQL Spatial Layer... Ctrl+Shift+M
% ?ésign_Template Open Attribute Table F6 [ Add DB2 Spatial Layer... Ctrl+Shift+2
nips . .
7 Urban_Flooding Toggle Editing Add Oracle Spatial Layer... Ctrl+Shift+O
tel Save Layer Edits Add/Edit Virtual Layer...
rflogs Current Edits @ Add WMS/WMTS Layer... Ctrl+Shift+W
‘ogram Files Save As @ Add ArcGIS MapServer Layer...
‘ogram Files (x86) N
Jthon27 Save As Layer Definition File... % Add WCS Layer..
L Remove Layer/Group Ctrl+D 6@ Add WFS Layer...
1 Duplicate Layer(s) ’E,'E Add ArcGIS FeatureServer Layer...
Layers
¢ d®T v Set Scale Visibility of Layer(s)
Set CRS of Layer(s) Ctrl+Shift+C
Set Project CRS from Layer
Layer Properties...
Filter... Ctrl+F
Labeling
Show in Overview
o0 Show All in Overview
Hide All from Overview

e In the new dialogue window use the button to browse to the folder containing the
table we want to add. Check the Geometry definition it should appear similar to the one
below. Geometry helps in defining the geographic locations, in this data Longitude is used
for the X coordinates and Latitudes are used for Y coordinates.

4|Page



Q

s« Data Source Manager | Delimited Text

v File Format

@ 5V (comma separated values)
' Regular expression delimiter

| Custom delimiters

v Record and Fields Options

b Layer Settings
Sample Data

Name  Latitude Longitude Class1

Close

Once selected click Add to add the table to the map canvas.
Your screen should be similar to this
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File name |C:\Godwin\Tutorials\Data\QGIS_Training_data\Vector\Populated_places.csv
Layer name Populated_places Encoding UTF-8

Number of header lines to discard 0 = Decimal separator is comma
+/ | First record has field names Trim fields
v/ | Detect field types Discard empty fields
v Geometry Definition
® Point coordinates X field | Longitude
 Well known text (WKT) Y field | Latitude
' No geometry (attribute only table) DMS coordinates
Geometry CRS EPSG:4326 - WGS 84

Class2 Country

Help



Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh SCP Processing Help
LEBREY Oppe nHAPPRPLA/EBRDS @ RrEB-LEEH#I=E -
L. A = @ 5 Qe - 2

PPHEEE- - A6 OCBHEEEE Dist 0.010000 |+ | Min60  +|Max 100 |5 © BIEEE] T - [E-

Browser (=]
OTHO
* 9 Data

» [7 QGIS_Training_data ™

» [ Rasters

v E Vector

> 05 area_of_study

1 - »
Layers B P
@l & T &~ A O

v @ Populated_places

Q. Type to locate (Ctrl+K) ileg z| 30.482,1.036 | o[1:834517 ~ | @ r[100% |2]: 00° +| v Render € EPSG:4326 @

3.2 Export CSV layer as Point shapefile.
Now we have populated places in QGIS, but the format of the data is comma delimited values (csv) for
further analysis we need the data as a point shapefile. Now we are going to save populated places table
as a point shapefile.

* Shapefile is a digital vector storage format for storing geometric location and associated attribute
information, They can be used in different GIS platforms such as ArcGlIS, QGIS and AutoCAD*.
e RIGHT Click on Populated_places > Export = Save feature as
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Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh SCP Processing Help

NEEnRRY DL, " BPPR . OMY e

B@QV./Aw @ L

FPoIEE - A

Browser
OTHO
‘ I-fl Data

» [ QGIS_Training_data

b [ Rasters

v |=_!| Vector

> 5 area_of study

(R area_of study.shp

(A borehole_points.c
I Ke
[ mashuru_clipped_shar
("] Mashuru_Output_shps
] New folder
9 ocha-rosea-ef819e1b

= 0jpg

v v v v v

Layers

v

g) Zoom to Layer
Zoom to Selection

Show in Overview
Show Feature Count
Copy Layer
Rename Layer

[_! Duplicate Layer

[l Remove Layer...

Open Attribute Table
Filter...

Change Data Source...

Set Layer Scale Visibility...

Set CRS

-H-8-5)
= 9 =

_ﬂmm_nmﬁmgog|¢| Min 60 |$| Max| 100 |:|@m

Save Features As...

I Styles Save Selected Features As...
Populated places Properties... Save as Layer Definition File...
Save as QGIS Layer Style File...
e On the new dialogue window select ESRI Shapefile as the format, use L button to navigate

and select a folder to save the new shapefile. Name the new shapefile
Populated_Places_Points.shp

e Click Ok.
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(X Save Vector Layer as... X

Format ESRI Shapefile v

File name a\QGIS_Training_data\Vector\Populated_Places.shp &

Layer name

CRS EPS5G:4326 - WG5S 84 v ||

Encoding UTF-8 v
Save only selected features
» Select fields to export and their export options

v Geometry

Geometry type Automatic v
Force multi-type

Include z-dimension

> Extent (current: layer)
v Layer Options
RESIZE NO >

+/| Add saved file to map | oK | Cancel Help

e The new layer appears on the layers tab as seen below
< ' >
Layers B ®
& [ % T & v i@ il

Populated_Places Points

V| © Populated_places

e Toremove Populated_places table. Click on Populated _places > Remove layer 2 OK.
e The layer is removed

4 ' »
Layers B ®
« [l % T &~ AF L

v @ Populated Places Points

To this point we have added tabular data to QGIS and converted the tabular data to a point
shapefile.
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Now we need to apply labels to the points on the canvas in order to view the name of
the location. To do this we will use the Name column in the attribute table.

e Click on Populated_Places_Points = Properties = Labels

e Select Single labels label with select Name click OK

(2 Layer Properties - Populated_Places Points | Labels X

Q Single labels v || €

Label with |Hbc Name| v | &
v Text Sample

Lorem Ipsum

Diagrams -~
3D View Lorem Ipsum 6/ /1:908701 v | &Y -
Source sbe Taxt Placement
Fields <% Formatting =
Attributes e Buffer A Cart hic O Around polnt (@) Offset f it
Form @ Backgrour artographic () Around point (@ Offset from poin
Joins - Shadow
* Placement
3 Auxiliary / Renderi Quadrant €,
- ~/ Renderin
=¥ Storage 9
& Actions
® Display Offset X,Y | 0.0000 2 0.0000 : €
4" Rendering Millimeter - | €
Variables o -
X Rotation | 0.00 i
! Metadata
™ Dependencie y , v Data defined -
Legend - | style + | OK Cancel Apply Help

e Your canvas should be similar to the one below
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Browser @
JeT®o
* 9 Data -
» ] QGIS_Training_data
» [ Rasters
hd I-'j Vector
* 5 area_of_study
02 area_of study.shp
(3 borehole_points.csv
» [Ike
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» [ New folder
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+ 0jpg -
[ »

Layers ® @afa rsa
¢ A& TEBRO

v @ Populated Places_Points
v © Populated places

On far left of the Main Menu click = Projects > Save

g’lalka Galla

‘Sericho

Vectc

Edit View Layer Settings Plugins
[l New Ctrl+N
New from Template
Open... Ctrl+O
Open From

Open Recent

Close

Save To

Revert...

Snapping Options...

Import/Export
[75) New Print Layout... Ctrl+P
@ New Report...
@ Layout Manager...

Layouts

Exit QGIS Ctrl+Q

S Save Ctrl+S

=l Save As... Ctrl+Shift+S

Properties... Ctrl+Shift+P

&

d

i

4

Lle

g W T C s ]

Save your QGIS work on a working chosen folder.

Adding Vector Data
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Vector data in GIS include Points, polygons and lines. In this exercise we are going to add points,
polygons and lines. *Note that different geographic features are categorized as points, lines or polygon.
For instance in our exercise we will add points, which are locations of populated places or boreholes; for
polygon, we will add the area of study boundary ; for lines we will add rivers/Stream networks in our study
area*.

(a) Adding Points

In this exercise we are going to add points into our QGIS. The points are locations of boreholes
in the study area. We are going to add using Add Vector Layer function in QGIS

e Start QGIS
e Click Layer - Add Layer->Add Vector Layer...

B4 Settings Plugins Vector Raster Database Web Mesh SCP Processing Help

. %Qata Source Manager Ctrl+L = @ S BT =
Create Layer 4 .

I Add Layer " Add Vector Layer... Ctrl+Shift+V
Embed Layers and Groups... 'u Add Raster Layer... Ctrl+Shift+R
Add from Layer Definition File... ﬁg Add Mesh Layer...
Copy Style 95 Add Delimited Text Layer...
Paste Style 'u Add PostGIS Layers... Ctrl+Shift+D
Copy Layer /% Add Spatialite Layer... Ctrl+Shift+L
Paste Layer/Group R Add MSSQL Spatial Layer... Ctrl+Shift+M
Open Attribute Table F6 (5, Add DB2 Spatial Layer... Ctrl+Shift+2
Toggle Editing @, Add Oracle Spatial Layer... Ctrl+Shift+O
Save Layer Edits Add/Edit Virtual Layer...
Current Edits 68 Add WMS/WMTS Layer... Ctrl+Shift+W
Save As... @ Add ArcGIS MapServer Layer...
Save As Layer Definition File... % Add WCS Layer...

[l Remove Layer/Group Ctrl+D (‘VQ Add WFS Layer...

Duplicate Layer(s) &+ Add ArcGIS FeatureServer Layer...

e Inthe new dialogue window, use the ' button to navigate to the folder with the data
e The point’s shapefile is in the folder named Vector.
e Navigate to the folder and select Boreholes.shp click open.
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Organize ~

= This PC
_J 3D Objects
I Desktop
Documents
¥ Downloads
15 Music
=] Pictures
ﬁ Videos
2305(C)

¥ Nehaark

@., Open OGR Supported Vector Dataset(s)

« QGIS_Training_data » Vector

New folder

~

v

<

Name

1] Boreholes.qpj
[] Boreholes.shp
D Boreholes.shx
1] New_boreholes.cpg
D New_boreholes.dbf
1] New_boreholes.prj
1] New_boreholes.qpj
D New_boreholes.shp

D New_boreholes.shx
'_H (aY 1 I ma

v O

File name: ‘Boreholes.shp

~ | All files

Search Vector

= m @

Date modified

9/4/2020 4:01 PM
9/4/2020 4:01 PM
9/4/2020 4:01 PM
9/7/2020 2:40 PM
9/7/2020 2:40 PM
9/7/2020 2:40 PM
9/7/2020 2:40 PM
9/7/2020 2:40 PM
9/7/2020 2:40 PM

N N N T

Open

v Cancel

~

e |nthe new dialogue window click add.
e The layer is added to the map canvas, It should appear similar to the one below
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~ e
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Ready

e
> B

]
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Coordinate 38.866,1.471 P§ Scale 1:727375 =

= Magnifier 100%

= Rotation | 0.0°

*  Render @ EPSGa37e @

We have successfully added points to our map. In the next section we will add a Polygon.
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(b) Adding a Polygon

The polygon we intend to add in this section is the Area of study boundary.

e On the upper tab click Layers = Add Vector Layer...

Settings Plugins Vector Raster Database Web Mesh SCP Processing Help

{! Data Source Manager

Create Layer

Add Layer

Embed Layers and Groups...
Add from Layer Definition File...
Bl Copy Style

Paste Style

Ctrl+L

-

~a
= @

N-8-LEE#Z=m- M-
sbe @& 4
.+ Add Vector Layer... Ctrl+Shift+V

'u Add Raster Layer... Ctrl+Shift+R |20 :
ER Add Mesh Layer...

95 Add Delimited Text Layer...

@, Add PostGIS Layers... Ctrl+Shift+D

e Inthe dialogue use the

we want to add. Choose Area_of study.shp since the polygon is a shapefile.

Data Source Manadger | Vector

button to browse to the folder with the area of study data

Q Open OGR Supported Vector Dataset(s)

T « QGIS_Training_data » Vector

Organize ~ New folder
A
= This PC Name
_J 3D Objects 1] Area_of study.cpg
I Desktop | ] Area_of study.dbf

& Documents | ] Area_of study.prj

1] Area_of study.qpj

¥ Downloads
B Musi "] Area_of study.shp
usic —
rea_of_study.shx
| ] Area_of study.sh
= Pict ~
B FICtUres ] Boreholes.cpg
B videos '] Boreholes.dbf
£30S(C) "] Boreholes.prj
¥ Natwarle e

v O

File name: ‘Area_of_study.shp

W

Search Vector y o]

=~ 1 @
Date modified

9/4/2020 12:20 PM
9/4/2020 12:20 PM
9/4/2020 12:20 PM
9/4/2020 12:20 PM
9/4/2020 12:20 PM
9/4/2020 12:20 PM
9/4/2020 4:01 PM
9/4/2020 4:01 PM
9/4/2020 4:01 PM

All files R

Open v Cancel

~

e Once selected click Open
e In the next window click Add.

e Done that, a rectangle should appear on your canvas that indicates the extent of our
study area. *Note the fill color might not be similar to the one appearing below since QGIS
randomly assigns a fill color to a new layer but it’s okay*.
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irowser B
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iﬁ{ Favorites |4
» [&] Home
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e GeoPackage
f Spatialite
W postals
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@ Orade
DB2| DB2
B WMS/WMTS
b 6P XYZ Tiles
& wcs
L
ayers B®
LA S U - )
V| [l Area_of study
v @ Boreholes

e The new layer overlays the previous one, thus we can’t see the point’s data i.e
Boreholes. We are going to change the fill color (Symbology) of the Area of study layer in
order to be able to view all the layers in the canvas.

e Click on Area_of_study = Properties...
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@ @ ‘VS /% QD Zoom to Layer

Zoom to Selection

2 @2 Show in Overview

Erowser Show Feature Count
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Copy Layer
. Favorites ] L
b [&] Home ename Layer
» [ ! Duplicate Layer

@ GeoPackag [l Remove Layer...
f Spatialite Open Attribute Table

@ rostais | o Bt

P mssal ¢/ Toggle Editing

@ Oracle Eilter...

=5 DB2 Change Data Source...

@ wms/wm Set Layer Scale Visibility...
b & XYZ Tiles Set CRS |

@ wes €

A 4 e EXpOI’t |
ayers

Styl |

A ST 5 g

Properties...

Area oy siuu
v @ Boreholes

e On the new dialogue symbol Click on Symbology = Simple Fill 2 For Fill Style select No
Brush
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() Layer Properties - Area_of study | Symbology

| 5 Single symbol
@ Information el M Fin
'{g.\ Source . Slmp|e fill
Q’ Symbology
Labels
Diagrams
3D View
E Source ‘ '1'}?' ‘ ‘ 8 HE! ‘
Fields
= Attributes Symbol layer type Simple fill o
Form —
Fill color | |v| &L
Joins -
2 Auxiliary Fill style B solid | =8
* 7 Storage Stroke color [——— - €,
@ Actions Horizontal
- : Stroke width | || ||| vertical =N
® Display T Cross
& ‘ Rendering Stroke style 7//{ BDiagonal Ev
. st 22N FDiagonal @'
AfaBIEs m Diagonal X
H~ Metadata . : Dense 1 -
o Dependencie: » Layer Rend
Legend - | Style _v| | |T|p

Once selected, the dialogue window should appear similar to the one below
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:{:\? Source

& Symbology

€T |abels
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3D View

Source
Fields

Attributes
Form
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|3
=¥ Storage

{;'.® Actions

L) Display

4 Rendering
Variables

=~ Metadata

'ﬁ Dependencie:

Legend

-

() Layer Properties - Area_of study | Symbology X
‘ E Single symbol ~
* LIFil
L] Simple fill
i =h®!
Symbol layer type Simple fill v -
Fi color | - L
Fill style No Brush v @'
stroke color (N - <.
Stroke width | 0.260000 @ | 5| |Millimeter v @'
Stroke style Solid Line R =S
Join style ) Bevel AR =h
- X | 0.000000 s -
» Layer Rendering
Style ~ OK | Cancel Apply Help

e Onthe window click Apply then OK
e The symbology of the area of study layer changes and now appears as the one below.
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Browser
OETHO
Favorites - @
4 I“g‘l Home @
r [Jea
@ GeoPackage
fSpatiaLite
@ rostGls
P mssaL ®
@ Oracle
5 pe2
& WMS/WMTS ® o ®
b & XYZ Tiles
& wes

Layers [2]E]
o 0l &% T &l O @

Area_of study
v @ Boreholes o® @ ®

e Now we can see all the layers with the points (boreholes) inside the Polygon (Area of
study) boundary.

(c) Adding another polygon data

Using the same procedure as we used for the Area of study, we will add Sub-locations polygon
Layer

e C(Click Layer > Add layer > Add Vector Layer

e Navigate to the folder with the data (Vector), select Sub_locations.shp and Add.

e The Map canvas should appear similar to this one *the color in your canvas may be
different since QGIS automatically selects a color palate whenever a layer is added*.
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Browser (=]E)
- =
3&( Favorites |
> [4] Home
r e
0 GeoPackage
f Spatialite
@ rostais
P mssaL
@ Oradle
DB2 —
& WMS/WMTS
b & XYZ Tiles
@ wcs
A

-

Layers
Sub_locations

D Area_of study
@ Boreholes

As an exercise using the same procedure we used to change the symbology of Area of study
boundary, change the fill color of the Sub locations layer to enable the other feature layers
become visible.

e Click Sub_locations > Properties=>Symbology->Simple Fill = Fill style then select No
Brush
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() Layer Properties - Sub_locations | Symbology X
| ESingIe symbol b |
@ Information i L TFill
5{:\_\ SEnrET Simple fill
Labels
Diagrams
3D View
Source ‘ﬁ‘ ‘ﬁ‘ ‘g‘
Fields
Attributes Symbol layer type Simple fill v ||~
F - e
o Filolor | [ - e
Joins B
‘.’. otia Fill style | No Brush v | @'
Bl o oo | - -,
B Adti =
o Stroke width | 0.260000 @ 3| | Millimeter v | €,
o) Display
& Rendering Stroke style | Solid Line v | @,
Vel Join style |a Bevel b | @'
B/ Metadata o x 0.000000 |:| o %
N Dependencie: » Layer Rendering
—— = | Style v| | OK | | Cancel | | Apply | | Help

Click Ok and Apply.

The layer in the canvas should appear similar to the one below

20| Page




Browser
OR2THO
Favorites

» (8] Home
I

@ GeoPackage

ﬁSpatiaLite

@ postais

P mssal

@ Oracle

2 b2

B WMS/WMTS
» 6 XYZ Tiles

€ wes

A e

Layers

o 0l % T &~ AL
v | | Sub locations
v Area_of study
v @ Boreholes

FelER- - AA OCBNIK 0

GRS 0.010000 3 MM 60 |+ IE® 100 + O PIEEEHE (Ko 2E200/2

(d) Adding Lines

Here we are going to add lines (rivers shapefile layer) to the map canvas. Rivers in GIS are mostly
represented as lines or Polylines in some instances. Since lines fall under vector data format, the
procedure for adding them is quite similar with the procedure of adding points and polygons.

e Click on = Layer = Add Layer = Add Vector Layer...

IE\Sd Settings Plugins Vector Raster Database Web Mesh SCP  Processing Help

g Data Source Manager

Create Layer

Add Layer

Embed Layers and Groups...
Add from Layer Definition File...
Bl Copy Style
Paste Style

Ctrl+L

N RB-LEEEH I U

"y Add Vector Layer... Ctrl+Shift+V
'o Add Raster Layer... Ctrl+Shift+R
BB Add Mesh Layer...

95 Add Delimited Text Layer...

@, Add PostGIS Layers... Ctrl+Shift+D

e Onthe new dialogue window use the button to navigate to the folder with data. Our
data is in QGIS_TRAINING_DATA/Vector, select hydroshed_stream_networks.shp and

click Open
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Q Open OGR Supported Vector Dataset(s) X

T™ « QGIS_Training_data » Vector v © | Search Vector P
Organize ~ New folder =+ [ O
= This PC ” Name Date modified
B 3D Objects Ij hydroshed_stream_networks.sbn 9/3/2020 6:38 PM
B Desktop Ig hydroshed_stream_networks.shx 9/3/2020 6:38 PM
. L] hydroshed_stream_networks.shp 9/3/2020 6:38 PM
|ﬁ Documents
£] hydroshed_stream_networks.shp 9/3/2020 6:38 PM
¥ Downloads =
L] hydroshed_stream_networks.shx 9/3/2020 6:38 PM
d Music "] New_boreholes.cpg 9/7/2020 2:40 PM
&= Pictures || New_boreholes.dbf 9/7/2020 2:40 PM
B Videos | ] New_boreholes.prj 9/7/2020 2:40 PM
3505 (C) [ New_boreholes.qpj 9/7/2020 2:40 PM
5w [ [ [ AT AT T AA T
¥ Nehaark = >
File name: ‘hydroshed_stream_networks.shp v | All files 4
Open v Cancel

e In the next dialogue window click Add, then Close.

e The new layer is added to the canvas, it appears as shown below *The color of the streams
in your canvas may not be identical to the one below but there is no problem as explained
earlier*
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Browser
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Favorites -
» [&] Home
y O
@ GeoPackage

ﬂ SpatiaLite

@ postals

P mssat

@ Oracle

2 op2

@ WMs/WMTS
b6 XY Tiles

& wcs

A py

Layers B®
o Bl % T &~ &L
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v [_] Sub locations

v ] Area_of study

v @ Boreholes
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®

A= 0.010000 | [ITTY 60

-
-
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e We can see the layer is added to the map canvas

Summary

In this section we have worked on adding vector data and displaying it on a map canvas. These includes
points, lines and polygons. Furthermore we have learnt how to symbolize or change the Fill Color of

polygons.

We now move forward to the next section entailing Basic Vector based Spatial Analysis.

3.3 Basic vector data analysis

In this section we are going to carry out Query analysis on the boreholes, to view and extract
operational boreholes from the points we have.

e Next we carry on a Simple query analysis to identify operational and non-operational

boreholes.

e Turnoff all the other layers by unchecking the box before layers except Boreholes
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Layers @ ®
o il % T &, v B O

— hydroshed stream _networks

|:| Sub locations

|:| Area_of study
v @ Boreholes

e Right Click on Boreholes - Open Attribute Table

@ | ,EO Zoom to Layer
B Zoom to Selection
LRAT®*TO 2 Show in Overview
W Favorites Show Feature Count
> [8) Home Copy Layer
» DG Rename Layer
@ GeoPackage _
‘ﬂ Spatialite [L! Duplicate Layer
' PostGIS ] Remove Layer...
’ MS5QL Move to Top
@ Orade B Open Attribute Table
s DR2 -
€@ WMS/WMTS 4/ Toggle Editing
b & XYZ Tiles Filter...
@ wcs Change Data Source...
AP 3w e
Layers Set Layer Scale Visibility...
o @ &% T &~ DG Set CRS »
— hydroshed stre Export »
D Sub locations Styles N
D Area _of study

P rties...
Boreholes —ropertes

e The attribute table should be similar to the one below.
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(=) Boreholes :: Features Total: 34, Filtered: 34, Selected: 0 — O X

/ < L LT E &P B8 g
Boreholeld Status X Y =

1 23| Not operational  38.9709315652... 1.14903173253...
2 26 Not operational ~ 39.0882386956... 1.14114056569...
3 25 Not operational | 39.0882386956... 1.141140565689...
4 28 Operational 39.1020354917... 1.13209200847...
5 27 Not operational  39.0882385118... 1.13508738580...
6 30 Operational 38.5217105679... 0.87731321908...
7 29 Qperational 39.0972267821... 1.13331366821...
8 32 Not operational ~ 38.5685819794... 1.00431479743...
9 31 Operational 38.6357037694... 0.99222593043...

10 2 Not operational  38.6959873297... 1.14876225664...

11 1 Not operational 38.6764208900... 1.14004690200...

12 4 Not operational ~ 38.8747969126... 1.23703986155...

13 3 Not operational | 38.7406797545... 1.21626489120...

14 6 Not operational  38.6584086889... 1.41148303862...

15 5 Not operational | 38.8112151919...| 1.52912507468...

16 34 Not operational ~ 38.5258027889... 0.92373807728...

17 8 Not operational = 38.4696390085... 1.41144742500...

? Show All Features,,

e On the attribute table we can see that there are operational and non-operational
boreholes.

e On the Menu bar on the top click on the Expression tool. (*The tool is circled red in the
next screenshot*)
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(2 Boreholes :: Features Total: 34, Filtered: 34, Selected: 0 - O X
/ (= @ LT ER P B = ae
Boreholeld Status X Y =

1 23| Not operational  38.9709315652... 1.14903173253...
2 26 Not operational ~ 39.0882386956... 1.14114056569...
3 25 Not operational | 39.0882386956... 1.141140565689...
4 28 Operational 39.1020354917... 1.13209200847...
5 27 Not operational  39.0882385118... 1.13508738580...
6 30 Operational 38.5217105679... 0.87731321908...
7 29 Qperational 39.0972267821... 1.13331366821...
8 32 Not operational ~ 38.5685819794... 1.00431479743...
9 31 Operational 38.6357037694... 0.99222593043...

10 2 Not operational  38.6959873297... 1.14876225664...

11 1 Not operational 38.6764208900... 1.14004690200...

12 4 Not operational ~ 38.8747969126... 1.23703986155...

13 3 Not operational | 38.7406797545... 1.21626489120...

14 6 Not operational  38.6584086889... 1.41148303862...

15 5 Not operational | 38.8112151919...| 1.52912507468...

16 34 Not operational ~ 38.5258027889... 0.92373807728...

17 8 Not operational = 38.4696390085... 1.41144742500...

? Show All Features,,

e Onthe new dialogue window expand the Fields and Values section and Select Status and
the equal to (=) operator on the top.
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(2 Select by Expression - Boreholes

Expression Function Editor

Output preview: Expression is invalid (more info)

Help

Q Search...

{ v v v v v w

A . . A . . A A A A A

Aggregates
Arrays
Color
Conditionals
Conversions
Date and Time
Fields and Values
123 Boreholeld
NULL
abe Status
1.2 X
1.2 Y
Fuzzy Matching
General
Geometry
Map Layers
Maps
Math
Operators
Rasters
Record and Attributes
String
Variables
Recent (Selection)

Show Values

group field

Double-click to add field name to
expression string.

Right-Click on field name to open
context menu sample value loading
options.

Notes

Loading field values from WFS layers
isn't supported, before the layer is
actually inserted, ie. when building
queries.

Values | @ Search...

All Unique 10 Samples

'Not operational’
'‘Operational’
‘Opreational’

& Select Features |+ Close

e On the right side of the window, under Values click All Unique and double click on
Operational and Select Features then Close.

*Here we have created an expression that tells QGIS to get us all the boreholes that have

indicated Status as Operational*
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(2 Select by Expression - Boreholes

Expression Function Editor

= 'Operational'|

Output preview: 0

Help

L Search...

v v v v v v

A . . A . . A A A A A

Aggregates
Arrays
Color
Conditionals
Conversions
Date and Time
Fields and Values
123 Boreholeld
NULL
abe Status
1.2 ¥
1.2y
Fuzzy Matching
General
Geometry
Map Layers
Maps
Math
Operators
Rasters
Record and Attributes
String
Variables
Recent (Selection)

Show Values

group field

Double-click to add field name to
expression string.

Right-Click on field name to open
context menu sample value loading
options.

Notes

Loading field values from WFS layers
isn't supported, before the layer is
actually inserted, ie. when building
queries.

Values | <. Search...

All Unique 10 Samples

'‘Not operational’
'‘Operational’
‘Opreational’

& Select Features |+ Close

Close the attribute table, on the canvas we can see that some of the boreholes color has changed
to yellow. These are the boreholes that are operational. Remember our query was Status =
Operational, as a result QGIS has selected the operational boreholes and automatically
symbolized them with a yellow color.
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P mssaL
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& WMS/WMTS
b 6 XYZ Tiles
@ wcs
A

Layers
o @l % T &~ &AL

|:| Sub locations
|:| Area of study
Boreholes

A /o O RIS X £

B
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Now we are going to save the operational boreholes to use them for further analysis

e On the layers tab click on Boreholes = Properties 2Source = Query Builder
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Q Layer Properties - Boreholes | Source X

(2 Query Builder X

@ Information Set provider filter on Boreholes

Fields Values
TLEIE  Boreholeld | Q Search...
1&T5 Status
abels
X
Diagrams Y
3D View
Source
Fields
Attributes Sample I All
Form Use unfiltered layer
Joins v Operators
L Auxili
ﬂS;;!:Z/ = || < || > || e || % || IN | NOTIN |
<= || »>= || == | mnxe | ano || or || noT |

@ Actions |
m Display Provider specific filter expression
& Rendering |

Variables

ﬁk Metadata

ﬂ Dependencie

4 »
Legend

| OK || Test || Clear || Cancel || Help

e On the Query Builder type the same function we used earlier as show below

30| Page



® Query Builder X

Set provider filter on Area_boreholes

Fields Values
Boreholeld Q. Search...
Status Not operational
X Operational
Y Opreational
SLID
SLNAME
Sample All
V| Use unfiltered layer
v Operators
E < > LIKE % IN NOT IN
<= >= I= ILIKE AND OR NOT

Provider specific filter expression

= 'Operationall

4 »

‘ OK | Test Clear Cancel Help

e Click Ok on both the current window and previous window to close.
e The other points on the canvas (non-operational boreholes) disappear leaving only the
operational boreholes that were extracted from the expression.

Browser B®
OATHO
Favorites
» [&] Home
y DI e
@ GeoPackage
f Spatialite
@ rostalis
P mssal
@ Orade
3 b2
& WMS/WMTS
b & XYZ Tiles
@ wcs
A e b [}
Layers B®
@ % T &R TL
— hydroshed _stream_networks
D Sub locations
D Area_of study
Boreholes

fo

Note that on the canvas, we have a layer of operational boreholes only.

Now, export the layer and save as Operational_boreholes shapefiles.
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NB: Whenever you save files with more than two words in QGIS or ArcGlIS, you are required to
use an underscore instead of a space while naming the file/shapefile. This is because having a
space between words may result to errors during automation processes.

Summary

In this section we have learnt to add vector data to QGIS, change symbology and carry out a
simple query on the attributes of features. A query analysis helps us to select an aspect or feature
of interest in the attribute table of our feature datasets. For instance we have been able to select
operational boreholes from the status attribute of all boreholes in our study area.

Note that in this section, we only queried the attributes of the data. In the next section, we will
use geographic aspects of the data to carry out spatial analysis.

3.4 Spatial joins, intersection and distance-based analysis
Spatial analysis is defined as a way of looking at the geographical patterns of data and analyze
the relationships between the entities.

In this exercise, there are 3 main tasks;

e Adding sub-location name to each borehole,
e Assessing the number of boreholes per each sub-location,
e Assess the distance of boreholes from populated places.

3.4.1. Adding sub-locations names to each boreholes

The main goal in this section is to add the sub-location name to each borehole and thus you are
required to conduct a spatial join. In QGIS the tool for conducting spatial join is called JOIN
ATTRIBUTE BY LOCATION.

e On the top most tab, click on processing tools icon ", a new dialogue window appears
on the right side of the canvas (The shortcut is Ctrl+Alt+T)

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh SCP Processing Help
NEBRER? ML r  RPPR LN 8c-E-a-nEEEE =0 D-
A@V. L @ / = % = Qa® 22 B L*¢@
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BREY Hess NPPRA - BBEY - H-a-4ANEMI=-9N-
eV 2. @B Ly : - GeR 29 B @
F o2HEE- = BeLOHINE B mMUooowe s MMe s+ OEEENHE PEo “Ex s &= @Moe 3 23: =03
Browser L Processing Toolbox o=
ieTT0 = A -
1 Favorites = Search
v [&) Home + (1) Recently used
B v @ Cantography
& GeoPacksge v G} Database
# Spatialite + G File toals
W PostGis v G Graphics
P mssa v G intespolation
@ Oracle v G Layer tools
&8 pe2 v G Network analysis
@ WS WMTS ® v (3 Raster analysis
v XYZ Tiles ° v G Raster terrain analysis
S wes - v 3 Raster tocls
e 45 * (@ Vector analysis
[k o » @ Vector ereation
s St (B R BT v G Vector general
— hydroshed stream_networks v @ Vector geometry
|| Sub locations v G Vector overlay
[[] Area_of study + G Vector selection
v @ Boreholes b v @ Vector table
v & GDAL
® v @ GRASS
r®RR
v S SAGA
L]
°
.

e Inthe search bar on the processing toolbox, type Join Attributes by Location
e The tool appears as below, double click the tool to open.

Processing Toolbox ®
LI RONS VN
. Join Attributes by Location a

A (9 Recently used
Join attributes by location
v (@ Vector general

Join attributes by location

2., Join attributes by location (summary)

e Input the following Parameters; Input layer select Boreholes [EPSG: 4326], for Join layer
select Sub locations[EPSG:4326]~> RUN.
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(X Join Attributes by Location

Parameters Log

Join attributes by

Input layer

2" Boreholes [EPSG:4326] - || - |
Selected features only
Join layer
| Sub_locations [EPSG:4326] v ||

Selected features only

Geometric predicate

V| intersects overlaps
confains within
equals Crosses
touches

Fields to add (leave empty to use all fields) [optional]

Join type

|0 elements selected | |:

+ | location

This algorithm takes an input
vector layer and creates a new
vector layer that is an extended
version of the input one, with
additional attributes in its attribute
table.

The additional attributes and their
values are taken from a second
vector layer. A spatial criteria is
applied to select the values from
the second layer that are added to
each feature from the first layer in
the resulting one.

| Create separate feature for each located feature (one-to-many)

Discard records which could not be joined

Joined field prefix [optional]

Joined layer

+/| Open output file after running algorithm

Unjoinable features from first layer

|[Create temporary layer] | |:

|[Sk|'p output] | |:

| 0%

| Cancel

|Run as Batch Process... |

| Run || Close || Help

T 7T

o After the tool runs successfully click Close

e Onthe layers tab, a new layer named Joined layer should appear similar to the one

below.
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Layers B®
o m L 4 Y €|J v @i @ 0l

— hydroshed stream_networks

D Sub locations

D Area of study

v © Joined layer
v @ Boreholes

1

e To see if the sub location name is added to the boreholes layer, open and view the
attribute table

e Right click on the Joined layer -2 Open Attribute Table

DAY AN ./ 2 Zoom to Layer
@ - > | B o\ Zoom to Selection ;

Browser Show in Overview
GrT®*O Show Feature Count
f:’ Favorites Copy Layer
> 6] Home Rename Layer
r D _
@ GeoPackage Duplicate Layer
ﬁ Spatialite [ L Remove Layer...
; PostGIS Move to Iop
e
EE Open Attribute Table
@ Oradle . :
9 DR ¢/ Toggle Editing
@ wms/wMTS ilter...
’ @ XYZ Tiles Change Data Source...
@ wcs .
o s aen Set Layer Scale Visibility...

Layers Set CRS ’
@ & T &L Make Permanent...

— hydroshed stream _network Export »
D Sub locations

)
[ | Area of study Styles
Joined layer Properties...
v @ Boreholes T

e In the attribute table a new column named SLNAME has been added in the far right.
SLNAME is a short form for Sub-location name.
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10

11

[ |
-

Boreholeld

£
Status

11| Operational
10 Operational
13 Operational
12 Operational
29 Operational
28 Operational
31 Operational
14 Operational
30 Operational
16 Operational

15 Operational

(-2 Joined layer :: Features Total: 11, Filtered: 11, Selected: 0

LT E & D

X

38.6764296550...

38.6737294176...

38.6674407221...

38.6674407221...

39.0972267821...

39.1020354917...

38.6357037694...

38.8969326961...

38.5217105679...

38.6310100908...

38.6763321010...

1.05861517711...

1.09480676631...

1.06766218342...

1.06766218342...

1.13331366821...

1.13209200847 ...

0.99222593043...

1.31900744934...

0.87731321908...

1.71866377271...

1.76435498136...

SLID

402050301.000...

402050301.000...

402050301.000...

402050301.000...

402060201.000...

402060201.000...

402040202.000...

402050101.000...

402040301.000...

402050203.000...

402050203.000...

SLNAME
MERTI NORTH

MERTI NORTH

MERTI NORTH

MERTI NORTH

SERICHO

SERICHO

MUCHURO

MALKAGALLA

MALKADAKA

DUMA

DUMA

e Since the new boreholes layer has a sub location name for each borehole, save it and
remove the previous layer.

e Toremove Boreholes layer, right click on Boreholes layer > Remove Layer...
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Project Edit View Layer Settings Plugins Vector Raster

hEBRmEN UeLpp HPPA
Q % VE; ‘!% ﬁ ﬁloom to ..I_ayer
@ @ - Zoom to Selection

Browser Show in Overview

L E} THe Show Feature Count
. Favorites Copy Layer

b [&] Home

» DI Cy Rename Layer

@ GeoPackage L] Duplicate Layer

£ Spatialite B Remove Layer...

' PostGIS Move to Top

P mssal -

@ Orade Open Attribute Table

&2 pa2 J Toggle Editing

@ WMS/WMTS Filter...
b & XYZ Tiles Change Data Source...

@ wcs

@ WES Set Layer Scale Visibility...

® ows Set CRS '
Layers Export '
CRASTEYRD g '

V| @ Joined laye Properties...

Boreholes

V! ] Sub_locations

vl Area_of study
e C(Click OK in the new dialogue window that appears.
e The layer is removed from the legend.

Layers B®
¢ @l % T & vE L

— hydroshed stream _networks

D Sub locations

D Area_of study
V| © Joined layer -

e The new layer Joined layer is not saved, to continue with the analysis we need to save
the layer as a shapefile.

e Right Click on Joined layer—> Export = Save Feature As...
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WPV AW 5D Zoom to Layer b g
E @|__ Zoom to Selection IE| 0.010000|:|IM| 60 |:|m| 100|
—] Show in Overview
Browser
LeET™TO Show Feature Count
57 Favorites Copy Layer
b [A&] Home Rename Layer
g % &\ Duplicate Layer
GeoPackage
@]
ﬁ Spatialite [l Remove Layer... .
@ postGls Move to Top
P mssaL QOpen Attribute Table
@ Oradcle j Toggle Editing
s DB2
€ WMS/WMTS Filter...
» & XYZ Tiles Change Data Source...
@ wcs Set Layer Scale Visibility...
L T
Layers Set CRS 4
o [l % T &~ & & Make Permanent...
— hydroshed st Save Features As...
D Sub_location Styles » Save Selected Features As...
L] Aa_of_stud Properties... Save as Layer Definition File...
Joined layer
Save as QGIS Layer Style File...

e Onthe new dialogue window, input the following parameters, for Format select Esri
Shapefile; for file name type Area_boreholes.
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(2 Save Vector Layer as... 4

Format ESRI Shapefile v

File name }ata\QGIS_Training_data\Vector\Area_boreholes.shp| a |

Layer name

Paiy
" -tlJl

CRS EPS5G:4326 - WG5S 84 >

Encoding UTF-8 v
Save only selected features

v Select fields to export and their export options

Name Type
v/| Boreholeld Integer64

V| Status String

VX Real
vy Real v
Select All Deselect All
v/ Add saved file to map | OK | Cancel Help

e Click OK, the layer is saved and added to the legend, remove Joined Layer.
e The layers tab should appear similar to this one

ayers B®
« @ % T (79 !

— hydroshed _stream_networks
D Sub locations
D Area of study
v| © Area_boreholes
v © Joined layer -

Kudos, we have successfully carried out a spatial join, now all the boreholes have the name
of the sub location they are located in.

Turn all the layers on at this point.

Now we are going to carry out the next basic spatial analysis, point in polygon analysis. Here
we are going to use QGIS to determine the number of boreholes per sub location.
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3.4.2 Assess the number of boreholes per Sub location (Point in Polygon Analysis)

In this section we are going to assess the number of boreholes in each sub location and also
identify the sub location with the highest and lowest number of boreholes.

e Click on Vector 2 Analysis Tools = Count Points in Polygon...

Raster Database Web Mesh SCP Processing Help

Geoprocessing Tools ’E @ VR = N - 3>
Geometry Tools "= @ @ @
Ana 00 «* Line Intersections...

-

Data Management Tools E’: Mean Coordinate(s)...

¥, Basic Statistics for Fields...

-

Research Tools

0 0 olygo

@ Distance Matrix...

= List Unique Values...

& Nearest Neighbour Analysis...
2 Sum Line Lengths...

¢ Inthe new dialogue window input Polygon—>Sub_locations[EPSG:4326],
Points>Area_boreholes[EPSG:4326]-> Run.
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(X Count Points in Polygon

Parameters Log

Polygons
(2 sub_locations [EPSG:4326]

Selected features only
Points

N : Area_boreholes [EPSG:4326]

Selected features only
Weight field [optional]

Class field [optional]

Count field name
NUMPOINTS
Count

[Create temporary layer]

v/| Open output file after running algorithm

Run as Batch Process...

0%

Count points in
polygon

This algorithm takes a points
layer and a polygon layer and
counts the number of points
from the first one in each
polygons of the second one.

A new polygons layer is
generated, with the exact same
content as the input polygons
layer, but containing an
additional field with the points
count corresponding to each

polygon.

An optional weight field can be
used to assign weights to each
point. If set, the count
generated will be the sum of
the weight field for each point
contained by the polygon.

Alternatively, a unique class
field can be specified. If set,
points are classified based on
the selected attribute, and if
several points with the same
attribute value are within the
polygon, only one of them is
counted. The final count of the
point in a polygon is, therefore,
the count of different classes
that are found in it.

Both the weight field and
unique class field cannot be
specified. If they are, the
weight field will take
precedence and the unique
class field will be ignored.

Cancel

Run | Close Help

After running the tool a new layer is created named Count. It appears on the layers tab

as seen below

Layers

o [ % T

To view the number of boreholes per sub-location we now open the attribute table of

the new layer (Count).

[ = g

v [ count

v| © Area_boreholes
V' | | Sub locations
v ][] Area_of study

(=]ES]

Right Click on the new layer Count = Open Attribute Table
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Project Edit View Layer Settings Plugins Vector Raster

DR a0 " RHPD L

g] Zoom to Layer

AVAS
ﬂ ‘% - ',% ﬁ Zoom to Selection

E @ - Show in Overview
S Show Feature Count
OR_2THO

Copy Layer
. Favorites R L

» [&] Home ename Layer
Y Duplicate Layer

@ GeoPackage [l Remove Layer...

i Spatialite B Open Attribute Table
@ rostalis

™ mssal ¢/ Toggle Editing

@ Orade Filter...

= DB2 Change Data Source...

@ WMS/WMTS Set Layer Scale Visibility...
» & XYZ Tiles <ot RS ’

@ wcs e

& WFs Make Permanent...

OWS Export X
Layers Styles R
v % TVT&GuvRA _

Properties...
Count

v © Area boreholes
V| | Sub _locations
vi] Area_of study

e The attribute table has a column for polygon name named SLNAME and a column for
points in that polygon named NUMPOINTS. It should appear similar to this one
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¢ Count :: Features Total: 25, Filtered: 25, Selected: 0 —
o [ N EYo 2 B @ e
SLID SLNAME NUMPOINTS

1 | 402050402.000... BULTO BONSA 1
2 | 402050403.000... MATA ARBA 1
3 | 402050501.000... BULESA 1
4 | 402050502.000... GODA 0
5 | 402050203.000... DUMA 2
6 | 402050301.000... MERTI NORTH 6
7 | 402050302.000... MERTI SOUTH 1
8 | 402050401.000... KORBESA 1
9 | 402040301.000... MALKADAKA 1
10| 402050101.000... MALKAGALLA 3
11/ 402050201.000... YAMICHA 0
12| 402050202.000... URURA 1
13| 402040102.000... GARBA TULLA S... 0
14| 402040201.000... GAFARSA 0
15| 402040202.000... MUCHURO 1
16| 402060402.000... QURI 0
17| 503120601.000... ADHI-BOGOL 0
? Show All Features,,

e Now we can see the number of boreholes per Sub location. Merti north has the highest
number of boreholes with 6 boreholes, while there are several sub-locations with none
Close and save the project on a working folder, give it a name of your choice.

Summary

In this section we have carried out basic spatial analysis. Particularly we have conducted a spatial
join by adding sub locations names to boreholes such that in the boreholes attribute we can view
the sub location name where it is found. We have then carried out a point in polygon analysis, by
determining the number of boreholes in each sub location.

4. Basic Raster Analysis and Styling
Raster data models are widely used in GIS today. In this section we are going to learn how to add
Raster data to a GIS, conduct basic operation and basic spatial analysis. The most widely used
Raster format is the GeoTIFF format or TIFF format with an extension (.tif).

4.1 Adding raster data to QGIS.
To add raster data to QGIS, use the layer tab on the Main Menu. The process is similar to adding
vector data to QGIS, only that here the Add Raster Layer... function is used. First we will add
dist_to_water_ways raster.

e Open QGIS
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e Start a new project

Vector Raster

2ielfed Edit View Layer Settings Plugins

New from Template

Open... Ctrl+0

Open From

Open Recent

e Once opened, on the main menu right click on > Layer - Add Layer > Add Raster

Layer...
Settings Plugins Vector Raster Database Web Mesh SCP Processing Help
q Data Source Manager Ctrl+L e @Q % %g‘ z = ‘;
Create Layer ’ Ml HHE 2
A aye V; Add Vector Layer... Ctrl+Shift+V
Embed Layers and Groups... A
Add from Layer Definition File... @, Add Mesh Layer...
e Navigate to the folder with Distance to water ways using the "' button, once selected click
add.
Q Open GDAL Supported Raster Dataset(s) X
= v~ « QGIS_Training_data » Raster v ($] A~ Search Raster
Organize ~ New folder = - ™ @
Write_up 2
@ OneDrive Utp« -'; S )
= This PC ‘* E /
(alg

/&
T
|

_J 3D Objects
Kenya_Sentinel2_  Kenya SRTM30m dist_water_ways ken_ppp_2020

B Desktop LULC2016_LandU “Elevation
Documents selLandCover

¥ Downloads
J\ Music

= Pictures

ﬁ Videos

2508 (C)

File name: |dist_water_ways ~ | All files ~

Open Cancel
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e Click Open—> Add, to add the layer into your map

The canvas should appear similar to the one below

Browser (1]
O2THO

5.0 Favorites =
14 @ Home
28 - e

& GeoPackaae X
Layers @ ®

« il % T vE RO

v W/ & dist water ways
Mo

49.904

Having added the layer to our map canvas we now move to the next step that is analysis.

4.2 Distance to waterways
In this section we are going to calculate the distances from populated places to the nearest water

ways, this includes rivers, nearest streams and water sources in the area. We will use the layer
that we have just added and Populated places data.

e Next, add the populated places shapefile into our map
e Click Layers—> Add Layer-> Add Vector Layer...

IEYZ Settings Plugins Vector Raster Database Web Mesh SCP  Processing Help

% Data Source Manager Ctrl+L I S BT mv
Create Layer ’ Fdl AN :
Add Layer .+ Add Vector Layer... Ctrl+Shift+V
Embed Layers and Groups... 'Q Add Raster Layer... Ctrl+Shift+R
Add from Layer Definition File... ﬁg Add Mesh Layer...
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e Navigate to the folder with the populated places shapefiles using the

selected the layer click Open

button, Once

) 3D Objects
I Desktop
@ Documents
¥ Downloads
J\ Music

| Pictures

m Videos

2505 (C)

¥ Nohaarlk

Q Open OGR Supported Vector Dataset(s)

« QGIS_Training_data » Vector

W

« o v
Organize ~ New folder
A
@ This PC

<

Name
| | New_boreholes.shx

0 Populated_Places.cpg
B Populated_places
D Populated_Places.dbf
0 Populated_Places.prj
] Populated_Places.qpj
[ ] Populated_Places.shp
D Populated_Places.shx
] Sub_locations.cpg
D Sub_locations.dbf

v O

File name: ‘Populated_Places.shp

W

e On the new dialogue window click Add.
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Search Vector

All files

Date modified
97172020 2:40 PM

9/4/2020 2:52 PM
9/14/2020 11:49 AM
9/4/2020 2:52 PM
9/4/2020 2:52 PM
9/4/2020 2:52 PM
9/4/2020 2:52 PM
9/4/2020 2:52 PM
9/4/2020 12:19 PM

9/8/2020 12:57 PM
>

Open

v Cancel

=- o @

~

v




@, Data Source Manager | Vector X

i Source Type

(®) File () Directory ( ) Database ( ) Protocol: HTTP(S), cloud, etc.

Encoding UTF-8 -

Source

Vector Dataset(s) |win\TutoriaIs\Data\QG]S_Training_data\Vector\PDpuIated_PIal:es.shp a | |:|

Close | |( Add )| | Help
v

e The layer appears on the canvas
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Browser B®
OaTH®He
1.7 Favorites
b [&] Home
» O
& GeoPackaae

Layers
o [l % T & v | A O

v @ Populated Places
v W " dist water ways
Mo
49.904

@
®

To determine distances to water ways, we will classify distance to waterways layer and apply a
suitable symbology in order to identify places closer and further to waterways.

e Right click on dist_to_water_ways = Properties...
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v dist t z
. . |s walerw g_) Zoom to Layer

49.904 Show in Overview
Copy Layer
Rename Layer
&@ Zoom to Native Resolution (100%)
Stretch Using Current Extent
! Duplicate Layer
[ L Remove Layer...
Move to Top
Change Data Source...

Set Layer Scale Visibility...

Set CRS »
Export »
Styles 4

Click on Symbology 2 Render type = Singleband Pseudocolor - Color Ramp - select RdYIGn
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tabase Web Mesh SCP Processing Help
BBOR @c-H-u- -G EHfIa-9 M- I'IB'ues
S BrBG
e QOR o @B .
@ Layer Properti‘es - dist_water_ways | Symbology 1 supu
- v Band Rendering l GnBu
a . .
2t Information
Render type |Singleband pseudocolor + I Greens
':t\‘ Source M Greys
Band Band 1 (Gray)
& Symbology B inferno
Min 0 Max .
&8 Transparency Magma
_— » Min / Max Value Settings I OrRd
B Histogram r
. Interpolation Linear 1 Oranges
4 Rendering
& ] Color ramp _ I | PRGN
Pyramids
E Y Label unit Invert Color Ramp I 1 PivG
Metadata suffix
I Blues B Plasma
Val Col Lab
Legend alue olor abe ¥ Greens 1 PuBu
QGIS Server 0 . , 2 Greys 1 PuBuGH
B Magma I 1 Puor
12.4759998... 12.5 F1 RdGy 1 PuRd
H Reds 1 Purples
Spectral RdB
24.9519996. . 25 |15 Pl Rdu
B viridis I | rdGy
Mode | Continuous All Color Ramps 1 RdPu
- Create New Color Ramp... I 1 RdYIBu
Classify | |58 || = N =
Edit Color Ramp... B RdYIGn
Clip out of range values Save Color Ramp... 1 Reds
v Color Renderinn I I Spectral
Style ~ oK ‘ . Viridis
T M YiGn
Coordinate 38.189,1.163 | Scale 1:897902 ~ | {g Magnifi M YIGnBu
1 YIOrBr
Vi 9 =
1 YIORd

e Click Classify=> Apply=> OK
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Q Layer Properties - dist_water_ways | Symbology

v Band Rendering

@ Information

Render type |5ing|eband pseudocolor ¥ |

;@- Source

Band |Band 1 (Gray) hd |
& Symbology

Min 0 Max 49.904 |
& Transparency i i

» Min / Max Value Settings
Histogram |

b

Interpolation |Linear

Rendering -
Color ramp | . -

#& Pyramids

. Label unit | |
H Metadata suffix
= Legend Value Color Label | =
52 QGIS Server 0 . R
12.4759998... 125
24.9519996... 25
Mode |C0nt|nuous Classes |5 C|

Cllp out of range values

» Color Renderinn

-
| Style v| | OK || Cancel HI_'ApplyiH Help

Note that the symbology and legend of the dist_to_water_ways layer changes.

Browser [
oerv#®xe
‘Ff( Favorites
3 @ Home
r O _
& GeoPackade Y
Layers
« 3wV~ AO
V| © Populated Places
v V' ¥ dist water ways
Ho
125
25
374

M 199
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- From the legend, the least value with O represents regions closest to waterways while the
highest 49.9 which is given a green color represents the furthest areas from the water
ways.

- From the canvas we can see that all populated places within our study area are found
within the red region, indicating that they are all at a close proximity/nearer to water
ways.

4.3 Miscellaneous: Creating a distance raster from vector (lines) data
In the previous section, you have used existing distance to water ways raster data. What if you only had
the waterways as line (Vector) data, how can you create a raster data, depicting distance to water ways?

To achieve this, we will use .../Vectors/hydrosheds_stream_network.shp data. This are model derived
stream network data.

* Add Area_of_study.shp and hydrosheds_stream_network.shp to QGIS

Browser Processing Toalbox x|
V; devre T —; - - < a ; 1 sea |
L Favorites | -, . . '.
B | v Y spatial Bockmarks ) i e 1 S — v Recontly usod {
9 |+ [# Home o s o ™ TN 1y T, » @ Cartography
y 3 F » G} Database
e 1 GeoPackage » G File toals I
;.- £ Spatiatite K 3 ! s . X » G interpelation
a7 | W rosiGis I R » (2 Layer tooks
@ P omssal “ %N \ o v G Matwork analysis
] ?O'aci@ b b " . . { » @ Plots |
V. & DB2 I : -3 e ~ » 2 Raster anatysis |
7} L Y
e P WMSWMTS " e i » ) Raster creation |
B Vector Tiles | e X = 8 S ;. » G Raster torrain analysis
b 52 X7 Tiles A\ 3 L% \ b | » (2 Raster tools
& wes o > 3 “\ \ - : kol 1 G Vector analysis |
) WES / OGLC API - Features 1 : ¢ ¢ 5, ( J » Q@ Vector creation |
ows - L TN N » @ Vector genesa |
B ArchIS Map Service O e £ 1 G Vector geometry !
W AucGIS Fealure Service s - 2 e 4 R | » QR Vector overlay |
3 Geohode : 7 & \ | » (3 Vector selaction |
a " ‘ \ : » G vector table
e 2 p - 1 b G Vector tiles
» £ DataPlotly
“ . \ < 1 A » o GDaL
4 i * W GRASS
w » 4 ggis2web
i~ / @R
& » & SAGA
Layers ok e
I%Y i3 R0
W | Area of study iy
hydroshed stream _networks
"
Search OMS | Processing Toolbax
e : 3 i | Results Viewer
75
il
J
4 i
% rd
e %
A
FRoeacy Cocedinate. 39.0962,0.7523 'R Scale 10452691 = | @ Magnifier 100% |3 Rotation 0.0° * W Rendes WEpsGaIze @ |

e Before you run any distance-related analysis, you have to confirm that the projection of
your data is not in a geographic projection (with distances measured in degrees) but is in
an equidistant projection, where distance is measured in metric units e.g. meters,
centimeter of kilometer

e Goto properties of the hydroshed_stream_network.shp data and check the projection of
the data. Right click = Properties = Information
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I 1 - N 1

(. Layer Properties — hydroshed_stream_networks — Information X

. . -
. Information from provider
F .
Informatior

o Name hydroshed_stream_networks
3 : Path C

3\ Source {francis\QGIS_Training_dataWVectorthydroshed_stream_networks.shp

Y St ESRI Shapefil
& Symbology C:n:az:n ¢ apetie

Encoding UTF-8

- Geometry Line (MultilineString)
CRS EPSG:4326 - WGS 84 - Geographic
Extent 38.4520929603575610,0.8151039684745681 :

39.1776293960540585,1.7870882090913516
Unit degrees
Diagrams Feature 225
count
Fields
Attributes Identification
Form
: Identifier
Joins Parent Identifier
L Auxiliary Title
- '
ﬁ Storage Type dataset
Language
@ Actions Abstract
- Categories
, Display Keywords

rFa
@’ Rendering

Extent
ﬁ Temporal

CRS
Variables Spatial Extent CRS: - Projected
~ X Minimum: 0
a Metadata ¥ Minimum: 0 -
ﬂ' Dependenci s VN < | 0K | Cancel Apply Help

e You can see that the CRS (Coordinate Reference System) is Geographic and the unit of
measurements are in degrees. This means that to calculate accurate distance in metric
units, we have to Reproject the data to a distance conserving projection like UTM
(Universal Transverse Mercator) projection.

e Search for Reproject layer in the processing Toolbox
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Processing Toolbox ®
BeA O D K
<. Reproject a
hd CL) Recently used
- 3 Reproject layer
~ (2 Vector general
§§§' Assign projection
3 Define Shapefile projection
Reproject layer
v W GDAL
¥ Raster projections
T Warp (reproject)

e Click on Reproject Layer tool - Input layer (select hydroshed_stream_networks) 2>
Target projection (select UTM Zone 37N) = Run

Q Reproject Layer (2 Coordinate Reference System Selector X
‘ ) Filter | & UTM Zone 371 a|
Parameters Log Repl' Recently Used Coordinate Reference Systems
Input layer “ | This alg{ Coordinate Reference System Authority ID
4/ hydroshed_stream_networks [EPSG:4326] 6D R - 'tﬂyfgarﬁf' WGS 84 / UTM zone 37N EPSG:32637
Selected features only qnef bUt
reprojeq|
Target CRS i Attributd < 3
EPSG:32637 - WGS 84 [ UTM zone 37N v || algorithr _ _
Predefined Coordinate Reference Systems Hide deprecated CRSs
v Advanced Parameters -
Coordinate Reference System Authority ID
Coordinate operation [optional] WGS 72BE / UTM zone 37N EPSG:32437
Transformation Accuracy (meters) Arei WGS 84 /UTM zone 37N EPSG:32637
) Yemen NGN96 / UTM zone 37N EPSG:5836 -
L UTM zone 37N - EPSG:16037| Unknown World - N hemis 7 S
WGS 84 [ UTM zone 37N -
= WKT
PROJCRS["WGS 84 / UIM z
. | one 37N",
\ 0% | BASEGEOGCRS ["WGS 84
Run as Batch Process... ‘ Run DATIMI"Warld Ga |~ !
- — — — — - - el | oK | Cancel Help

e Note that here, we have saved the reprojected data as a temporary layer (Reprojected),

should you want to save the reprojected layer then select save file before you run the
Reproject Layer Tool

e You now end up with a Reprojected stream network data
Layers @ ®
¢ @|%Ta&~vA AL

v || Area_of study
v — Reprojected £
v — hydroshed_stream_networks
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e The projection of the Reprojected layer has now changed to UTM Zone 37N-Projected,
and the units are in meters

o)
L

o Informatior

. J& Source

s
3 Symbology

& €1 Labels

(2 Layer Properties — Reprojected — Information X

Information from provider

Name Reprojected

Source MultiLineString?crs=EPSG:
32637&field=ARCID:ong(10,0)&field=UP_CELLS:long(10,0)8wuid={
8131b5e2-b609-49f8-afd8-59a831c8bd3 1}

Storage Memory storage

Comment

Encoding

Geometry Line (MultiLineString)

G:32637 - WGS 84 / UTM zone 37N - Projected
439057.4684415727386114,90095.8234517230011988 :
519757.0078324576606974,197528.4902753207716160

Extent

Diagrams meters
re count 22
Fields
Attributes |dentification
Form
loins Identifier
: Parent Identifier
- Auxiliary Title
=M Storage Type
Language
@ Actions Abstract
Categories
, Display Keywords
Fa
4 Rendering
@ Extent
Temporal
CRS

Variables

a Metadata

ﬁ Dependenci gV PR 4 |

Spatial Extent
Temporal Extent

oK |

Help

Cancel Apply

e You can now use the reprojected stream networks to create a distance raster. This will
take place in two steps, first we have to create a raster or the stream networks, because
they will be used as the target. This process is called rasterizing.

e Secondly you will use the proximity tool to estimate the distances of each pixel from these

target cells.

e To rasterize, we use the Rasterize tool that comes under the GDAL Tools, search for

Rasterize in the Processing tools
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Processing Toolbox B®
a0 O N
A rasterize a
+® Recently used
" Rasterize (vector to raster)
v (2 Raster tools
‘%ﬁ? Convert map to raster
v o GDAL
* Vector conversion
" Rasterize (overwrite with attribute)
" Rasterize (overwrite with fixed value)
Rasterize (vector to raster)
v & GRASS
¥ Raster (r.%)
@ r.surf.contour
~* Vector (v.%)

@ v.to.rast
&

&

e C(lick on the tool, and set the parameters accordingly, in particular, the variables that are

important/compulsory in this case are
0 Vector layer to rasterize (Reprojected)

0 Afixed value to burn (this is the value that will be assigned to the rasterized stream
— Here we have set it to 1)

0 Resolution of the resulting raster, here we have set it as 100m (Georeferenced
units)

0 The extent of analysis (Here we selected the extents of Reprojected Layer)

e Once you have set all the necessary parameters, you can run the tool
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Q Rasterize (Vector to Raster)

Parameters ‘ Log

Input layer

—x—_
/" Reprojected [EPSG:32637] |
—_—

Selected features only

Field to use for a burn-in value [optional]

— T —
A fixed value to burn [optional]

|1.000000

FY
e

Qutput raster size units

| Georeferenced units ’

Width/Horizontal resolution

|100.000000

Height/Vertical resolution

|100.000000

Output extent \

|43905}'.4684,519?5?.00}'8,90095.8235,19}'528.4903 [EPSG:32637] \

Assign a specified nodata value to output bands [optional] \

1-9999,000000 \

——
v Advanced Parameters\_/J

Additional creation options [optional]

Profile | Default

Name

Value

|E| |E| | Validate | | Help

Qutput data type

| Float32

Pre-initialize the output image with value [optional]

| Not set

Invert rasterization

Additional command-line parameters [optional]

Rasterized

|[Save to temporary file]

]

+/| Open output file after running algorithm

| 0%

| Cancel

|Run as Batch Process... |

Run H Close || Help

e You then end up with a rasterized stream network
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pr————" I IP——— —e
Project Edit View Layer Settings Plugins Vectgr Raster [atabase Web Mesh SCP Progessing Help
he@RRY NLL2RPRAKA.BLICRE omEWE=S-¢ o -
L AL LT
HY EH-5-%- POEEE-

Browser (7]
derre

Gae ~s8¢ B
~ A& ALPEEINE B Moo s MM 0w : ONEEEIE VO cEx: B BHoe :3: 203 = L&

7 Favorites
+ " Spatial Bockmarks
» 8] Harne
r ey
& GeoPackage
#° spatalite
W@ roscis
P mssoL
@ Orade
& a2
B WS WMTS
BH vector Thes
b X2 Tiles
B wes
7 WFS / OGC API - Features
5 ows
@ ArcGIS Map Service
&7 ArctIS Feature Service
¥ GeoNode

SHHBAENBNS

Layers L]
vieYR~AAO
* ¥ & Rasterized o
| B
1
Area_of study
— Reprojected o
— hydroshed stream networks

1 Tipe b fecnbe (Ch1+K)

Coordinate 76.7897,1.0954 B Soale 1457668 ~ | g Magrifier 100%

Processing Toolbox [T
S a a0 B
| rasterize a

= 1 1) Recently used
" Rasterize (vector to raster)
* @ Raster toals
#F Convert map to raster
- & GOAL
= Vector conversion
" Rastesize [overwrite with attribute)
"= Rasterize foverwrite with fived vabue)
"o Rasterize (vector to rasted)
- @ GRASS
- Raster (1.%)
@ r.surf.contous
* Vector {v.")
W wtorast

- @son
" & Rastorae

Search QMS  Processing Toolbox
Results Viewer LE

Rotion 0.0° 5 Render @epscioze @

You are now ready for the final step, which is to create the proximity layer.
Search for Proximity (raster distance) tool from processing tool bar. This is also a tool

within the GDAL tools

Processing Toolbox @®
eSO RN
| & proximity a

v (D Recently used
S Proximity (raster distance)
@ Proximity raster

(@ Vector general
% Join attributes by nearest

&% GDAL

¥ Raster analysis

1

4

% Proximity (raster distance)

4

& saGa

¥ Raster tools
@ Proximity raster
@ Raster proximity buffer
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e Set the appropriate parameters, and run the tool. In particular
0 set the correct rasterized input layer,
0 setthe pixel value to be used as target (in our case we set it to 1 as this is the value
that we had assigned to the target pixels)
0 Set the Distance units to georeferenced coordinates.

(= Proximity (Raster Distance) X

Parameters Log

Input layer

=" Rasterized [EPSG:32637] -
Band number

Band 1 (Gray)

A list of pixel values in the source image to be considered target pixels [optional]

1
Distance units

Georeferenced coordinates
The maximum distance to be generated [optional]

Not set =
Value to be applied to all pixels that are within the -maxdist of target pixels [optional]

Not set =
4 Nodata value to use for the destination proximity raster [optional]

-9999.000000

4

v Advanced Parameters

Additional creation options [optional]

Profile | Default

| Name Value

@ | | = | Validate Help

Additional command-line parameters [optional]

Qutput data type
Float32

Proximity map

[Save to temporary file]

v/ | Open output file after running algorithm
GDAL/OGR console call

python3 -m gdal_proximity -srcband 1 -distunits GEO -values 1 -nodata -9999.0 -ot Float32 -of GTiff C:/Users/oloof/
AppData/Local/Temp/processing_0BkIMv/fa1048e2d7ee4047aBe6d2aadc4beaf7/OUTPUT tif C:/Users/oloof/AppData/
Local/Temp/processing_OBkIMv/c451061a71804420b58297354a46dd44/OUTPUT.tif

0% Cancel

!l Run as Batch Process... Run Close Help

o
e The result proximity map, showing distances (in meters) from the stream networks
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e You can change the symbols of the proximity map accordingly.
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Srowser
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+ 6] Home
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& GeoPackage
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D ows

@ AicGIs Mep Senvce
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Layers
AT 210

v hydroshed stream networks
b B Provimity map
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| B
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Peprojected
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= Rotation | 0.0°

Progessing Toolbox
saa
Doy
= (01 Recently used
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4.4 Working with elevation (raster) data
The elevation of a geographic location is its height above or below a fixed reference point, most
commonly a reference geoid, and mathematical model of the Earth's sea level as an equipotential

gravitational surface.

In GIS, elevation data is commonly presented in raster format. This is more natural presentation
as elevation is continuous. A raster file representing elevation of the ground level known as a

Digital Elevation Model (DEM).

e To add elevation data to QGIS, Click on Layer>Add Layer-> Add Raster Layer
IEYEd Settings Plugins Vector Raster Database Web Mesh SCP  Processing Help

Create Layer

Copy Style
Paste Style
Copy Layer
Paste Layer/Group

Toggle Editing
Save Layer Edits
Current Edits

Save As...

Duplicate Layer(s)

e On the new dialogue click on

Q Data Source Manager

Embed Layers and Groups...
Add from Layer Definition File...

Open Attribute Table

Save As Layer Definition File...

['l Remove Layer/Group

Ctrl+L

F6

Ctrl+D

< @ =0 ®Zmv
faedl &y i B A

V; Add Vector Layer... Ctrl+Shift+V
B2 Add Mesh Layer...

95 Add Delimited Text Layer...
@, Add PostGIS Layers... Ctrl+Shift+D
/7 Add Spatialite Layer... Ctrl+Shift+L
R Add MSSQL Spatial Layer... Ctrl+Shift+M
1, Add DB2 Spatial Layer... Ctrl+Shift+2
@, Add Oracle Spatial Layer... Ctrl+Shift+O
Add/Edit Virtual Layer...
@ Add WMS/WMTS Layer... Ctrl+Shift+W

@ Add ArcGIS MapServer Layer...
€53 Add WCS Layer...
&) Add WFS Layer...

Qf@ Add ArcGIS FeatureServer Layer...

button to navigate to folder with raster files

The Elevation data is in QGIS_Training_data/Raster folder

Select Elevation.tif, then click on Open = Add
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Q Open GDAL Supported Raster Dataset(s)

Organize ~ New folder

|5 Documents & ~
&= Pictures o~

cso

geopsy

pyscripts Landcover
Raster

@ OneDrive

9 This PC

) 3D Objects
[ Desktop
@ Documents
¥ Downloads
Jﬁ Music

== Pictures
E Videos

% Local Disk (C)

~J

\

S
/

~

dist_water_ways

T « Local Disk (C:) » francis » QGIS_ Training_data » Raster

Elevation.tif

v ) | Search Raster

<

«l

Population.tif

File name: |Elevation.tif

v | Allfiles

L]
=

Cancel

e Click Open-> Add

e The layer is added to the Canvas. Right click and Zoom to layer as shown below
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Plugin -
f # sciPy ermor message, Please update GGIS to version 114,16 B mocs L
e Phugin 2 Boad e ‘

Sauiean
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4.5 Symbolizing Raster File
An Elevation Raster simply indicates the height of points on the earth’s surface above the mean
sea level. In our map we can simply see from the legend that higher (2791m) areas are
represented by whiter color while lower areas are represented by a darker color (-2). We are now
going to change the symbology (color) in order to apply a different color variation that best suites

Elevation representation.

Kindly note that the elevation data in this exercise has been resampled and may not be the

accurate representation of the elevation in Kenya
e Right click on the layer Elevation.tif = Properties... , This will open the dialog box so that

you can read and edit some of the properties of the raster data
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Project Edit View Layer Settings Plugins Vector Raster Data

hEAREY Uppell P4

R@Vo.Aawm @ i
T 20 - 1R R OBEEME B o

Browser 5D Zoom to Layer

(]
5 "" WO Show in Overview

5.7 Favorites Copy Layer
» [8] Home
y T Rename Layer

@ GeoPackage ﬁ Zoom to Native Resolution (100%)

£ Spatialite Stretch Using Current Extent

' PostGIS L] Duplicate Layer

P mssat 0

@ Oracle Remove Layer...

“F DR2 Change Data Source...

@ WMS/WMTS Set Layer Scale Visibility...
» & XYZ Tiles Set CRS »

@ wcs

&) WFS Export ’
Layers Styles ’
¢« B ®T v Properties...

Kenya SRTM30meters
M4
5054

e On the new dialogue window that appears click on Symbology, on Render type select
Singleband Pseudocolour Interpolation Linear. Next to the color ramp click on the view

more button '~ to view more select All Color Ramps and select one that is suitable.
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’ri Information
J@ Source

V Symbology
I_Lﬂ Transparency
Histogram
/4‘, Rendering

g Temporal

B Pyramids

E‘. Metadata
.

Legend

E QGIS Server

Q Layer Properties — Elevation.tif — Symbology
v Band Rendering

Render type |5ingleband pseudocolor ¥ |

Band \Band 1 (Gray) v \
Min -2 | Max 2791 \
» Min / Max Value Settings
Interpolation |Linear 2 |
Color ramp | - -
Label unit suffix | |
Value Color Label =
_2 . _2
696.25 696.25
1394.5 1394.5
-
Mode | Continuous | Classes |5 |+|
| Cassty | | || =[P ||| | B
Clip out of range values
v Color Rendering
| Style v| OK | | Cancel | | Apply | ‘ Help

e Once selected the color ramp, click Apply and Ok
e The layer on the canvas should appear similar to this one
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The red shades represent higher elevation points while blue and green areas represent low elevation
regions and yellow representing medium elevation areas.

In the next section we will determine the average elevation for each sub location.

4.6 Average elevation in each sub-location
In this section, we are going to find the average elevation of each sub-location in our study area.
This is just for demonstration of vector and raster data analysis. We will require; elevation data
(which is the RASTER value data), and the sub-locations (Which is the VECTOR zone data. In QGIS,
we will use a tool known as zonal statistics tool.

e Tothe current project, add area of study boundary,*/f you don’t remember the procedure,
check the earlier steps on adding Vector data to QGIS*.

e Add the sub-location shapefile

e Once added be sure to change the color, as shown earlier to indicate only the areas
boundary with no fill.

e [t should be similar to this one
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e To get the average elevation for each sub-location we will calculate the statistics for
each sub-location using the Zonal statistics tool.

e The Zonal statistics tool outputs a table with statistics such as Mean, Standard
Deviation, Median etc.

e In QGIS go to processing toolbox@, in the dialogue window, on the search box
type Zonal Statistics and press Enter.
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Processing Toolbox @
% A O %

. Zonal statistics|

»

w (. Raster analysis
9 Raster layer zonal statistics

onal histogram

¥ Raster (%)
@ r.stats.zonal
v & SAGA
¥ Geostatistics

@ Zonal multiple regression analysis (points and predict...
@ Zonal raster statistics

e Click on the Zonal Statics tool: under Raster layer select Elevation.tif under Vector

Layer Containing zones select Sub_location and finally click .... at statistics to
calculate box and uncheck the other variables and remain with only Mean checked.
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(2 Zonal Statistics X

Parameters Log Zonal statistics

Raster layer This algorithm calculates statistics

L . - of a raster layer for each feature of
=" Elevation.tif [EPSG:4326] an overlapping polygon vector
Raster band layer.
Band 1 (Gray) v

Vector layer containing zones
(9 sub_locations [EPSG:4326] v

Output column prefix

Statistics to calculate

1 options selected

(2 Multiple selection X

Count “ Select All

Sum | —
V| Mean Clear Selection

Median Toggle Selection
Std. dev.

Min O

Max

Range

Minority

Majority (mode)

Variety

Variance v

Cancel

0% Cancel

Run as Batch Process... | Run | Close Help

e Once done click OK and Run the tool.

e The tool adds the calculated elevation averages to the Sub_locations.shp attribute
table.

e Right Click on Sub_locations—> Attribute Table to view the averages. A column for
_mean has been added which contains values for average elevation in each sub-
location.
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(.} Sub_locations — Features Total: 25, Filtered: 25, Selected: 0
o g LT E S D
SLID SLNAME _mean
1 | 402050502.000...[ GODA 411.037433155...
2 | 402050501.000... BULESA A14.778894472...
3 | 402050403.000... MATA ARBA 280.967948717...
4 | 402050402.000... BULTO BONSA 305.300813008...
5 | 402050401.000... KORBESA 274.099656357...
6 | 402050302.000... MERTI SOUTH 343.788888888...
7 | 402050301.000... MERTI NORTH 304.838797814...
8 | 402050203.000... DUMA 317.421052631...
9 | 402050202.000... URURA 292.970254191...
10| 402050201.000... YAMICHA 316.885775862...
? Show All Features,,

Close the attribute table and save the project.

We have extracted the average elevation for each sub location and next we want to extract the
elevation of each borehole

4.7 Extract raster value (elevation) to each point (borehole)
We are going to extract the elevation of each location in which the boreholes are found. To
achieve this goal we are going to use a spatial analysis tool called Sample Raster analysis.

e Add Boreholes.shp as shown in the previous sections.

e Click on the Processing toolbox %

e Search for Sample Raster Analysis

e Double Click on the tool. Under Input point layer select Boreholes [EPSG:4326] for
Raster Layer to Sample input Elevation [EPSG:4326] , for output column prefix type
elevation.
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Q Sample Raster Values

Parameters Log

Input Point Layer
* " Boreholes [EPSG:4326] v 6 X L=

Selected features only

Raster Layer to sample

| " Elevation.tif [EPSG:4326) - |IT|

v Advanced Parameters

Qutput column prefix

lelevation |

Sampled Points

|[Create temporary layer] | |:v|

+/| Open output file after running algorithm

Sample raster
values

This algorithm creates a new
vector layer with the same
attributes of the input layer and
the raster values corresponding on
the point location.

If the raster layer has more than
one band, all the band values are
sampled.

| 0%

|Run as Batch Process... | |

Click Run.
After the tool runs a new layer named Sampled Points is generated.




v ® Sampled Points (=] [
v © Boreholes

Vv | | Sub locations
v | i Elevation.tif

m-

696.25
13945
2092.75

M o701

Open the attribute table to view the elevation height of each borehole.

The new layer is a layer with all the boreholes, with an addition of the elevation column.

(&) Sampled Points — Features Total: 34, Filtered: 34, Selected: 0 <
o g LT E S D BE = 58
Boreholeld Status X Y elevation_1 =
1 14 Operational 38.8969326961... 1.31900744934... 252
2 13 Operational 38.6674407221... 1.06766218342... 286
3 12 Operational 38.6674407221... 1.06766218342... 286
4 11 Operational 38.6764296550... 1.05861517711... 289
5 10 Operational 38.6737294176... 1.09480676631... 281
6 9 Not operational 38.8921373612... 1.20339982674... 254
7 8 Not operational 38.4696390085... 1.41144742500... 309
8 7 Opreational 38.6134646000... 1.40242807200... 291
9 6 Not operational 38.6584086889... 1.41148303862... 286
10 5 Not operational 38.8112151919... 1.52912507468... 278
? Show All Features,,

From the Attribute table we can see the last column has the elevation (elevation_1) of each
borehole.

e Using steps that we learnt earlier in the tutorial, export the new layer as a shapefile
and give it a name of your choice.
e Close the attribute table and save the project

We have learnt the third method to conduct spatial analysis to extract raster values for known
locations for instance elevation of boreholes in our study area.

4.8 Estimating population of people accessing specific boreholes
The next aspect of spatial analysis that we shall conduct will be to determine the number of
population using each borehole. This can be people within a 1km radius of the borehole. For this
task we shall require population (raster) data and boreholes (point) data.
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4.8.1 Changing projection of vector data

Spatial analysis requiring distance measurements require Layers to be converted to a projected
coordinate system such as Universal Transverse Mercator (UTM). This is because projected
coordinate systems to estimate accurate ground distances in metric units.

We will convert Boreholes shapefiles, which is in geographic coordinate system (World Geodetic
System — 1984) to a desired UTM projected coordinate system.

e In Processing toolbox type Project and enter
e Select Reproject Layers

Processing Toolbox 3
Bad 0= R

2 project a
v (Q Cartography -

4% Create style database from project
v (2 Raster tools
%{% Convert map to raster
¥ (@ Vector general
%{,'% Assign projection
4 Define Shapefile projection
% Find projection
v (Q Vector geometry
%J?E Project points (Cartesian)
3 GDAL
~ Raster projections

4

& Assign projection
@ Extract projection
T Warp (reproject)
& GRASS
¥ Raster (r.%)
@ r.proj
@ r.tileset
¥ Vector (v.%)
V.proj
v 38 qgis2web
¥ Export webmap

%{% Export project
&

-

4

e Once the tool is Open, under Input layer select Boreholes

e For Target CRS click on the “4 button and type WGS 84 / UTM zone 37N
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Q Reproject Layer

Parameters Log
Input layer
" Boreholes [EPSG:4326] v 6D X, [~
Selected features only
Target CRS
EPSG:4326 - WGS 84 >

v Advanced Parameters
Coordinate operation [optional]

Transformation Accuracy (meters)

1] Null geographic offset from WGS 84 to WGS 84

4 »

Null geographic offset from WGS 84 to
WGS 84

Area of use: World

+proj=ncop

Show superseded transforms.
Reprojected
[Create temporary layer]

/| Open output file after running algorithm

Click OK and then Run

e Anew layer is created named Reprojected

V| ® Sampled Points

Reprojected
V| © Boreholes

v'| | Sub locations
v || " Elevation.tif
m-
696.25
1394.5

4.8.2 Buffer analysis on vector data

s

- -
-rocessin_q Toolbox
) BF&A&O=] T %

Reproject layer k
r (@ Cartography

3 Create style database from project
r (2 Raster tools
ﬁﬂg‘ Convert map to raster

(@ Vector general
{Jé% Assign projection
‘{§§' Define Shapefile projection
3% Find projection

-3 Reproject layer
L A

project

This algorithm reprojects a vector
layer. Tt creates a new layer with
the same features as the input
one, but with geometries
reprojected to a new CRS.

Attributes are not modified by this | [
algorithm.

(2 Coordinate Reference System Selector X
Filter | & UTM Zone 37 a
Recently Used Coordinate Reference Systems
Coordinate Reference System Authority 1D
4 »

Predefined Coordinate Reference Systems Hide deprecated CRSs

Coordinate Reference System Authority ID -

WGS 84 / UTM zone 37N EP5G:32637

WGS 84 / UTM zone 37S EPSG:32737
Yemen NGN96 / UTM zone 37N EPSG:5836 =
4 »
WGS 84 / UTM zone 37N -
WKT
DROJCRS ["WGS 84 / UTM z
one 37N",

BASEGEOGCRS ["WGS 84

’
DATIIMI "World Ge

3| O

To create a polygon of uniform distance around vector features, we create a buffer. This is done through

a tool that is referred to as buffer analysis.
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We are going to use this layer to create a buffer of 1 km around each borehole.
On the topmost tab, click on Vector = Geoprocessing Tools =2 Buffer



Raster Database Web Mesh SCP Processing Help
Buffer...

Geoprocessing Tools

.....

@ Convex Hull...
i Difference...
i Dissolve...

97 Intersection...

Geometry Tools

Analysis Tools

Data Management Tools

v vy v 9w

Research Tools

P Symmetrical Difference...

' Union...

P Eliminate Selected Polygons...

e On the new dialogue window, under Input layer select Reprojected [EPSG:32737] For
distance Input 1.0 and select Kilometers.

1
| @ Buffer X
S 4
Parameters | Log Buffer
Input layer This algorithm computes a buffer
o . . || 4 || |areafor all the features in an input
< Reprojected [EPSG:32737] M ||—| |3| layer, using a fixed or dynamic
Selected features only distance.
Distance The segments p_arameter controls
the number of line segments to
|1_000000 a |:| |ki|ometers - | @' use to approximate a quarter circle

when creating rounded offsets.

Segments The end cap style parameter

5 '$|| | controls how line endings are
handled in the buffer.

End cap style
P sty The join style parameter specifies

|Round v | whether round, miter or beveled
joins should be used when

Join style offsetting corners in a line.
|R9U"d h | The miter limit parameter is only
Miter limit applicable for miter jc_Jin styles,
and controls the maximum
|2_000000 |: distance from the offset curve to
use when creating a mitered join.
Dissolve result
Buffered
|[Create temporary layer] | |:|
v/ | Open output file after running algorithm
| 0% | Cancel
|Run as Batch Pmcess...| | Run | | Close | | Help

e Click Run
e A new layer named Buffered is created and automatically added to the map.
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® Sampled Points =
Buffered

@ Reprojected

© Boreholes

D Sub locations
M " Elevation.tif
M- =

1] EL

e The new layer Buffered indicates areas of radius 1km created around each borehole.
e We can see that the layer is indicated as circles around boreholes.
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e \We are again going to use Zonal statistics to determine the number of People within this

region for each borehole.

e Now click the population data which is in Raster format, in the Raster folder, indicated as

Population add it to the map.
e Once added the map should appear similar to this one
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Browser

2T
Favorites =
v 1" Spatial Bookmarks

b 0] Home
0 o\
& GeoPackage
£ Spatialite
@ rostals
P mssaL
@ Orade
D2
A9 WMS/WMTS =

SCP Dock =

SCP Version 6.4.7 - Greenbelt

=4 dE S

Train'ng input I(l Home

Plugin

# 5Py emror message. Please
update ()GIS to version 3.14.16
Read maore

# Developing the new Semi-
Automalic Classification Plugin 7
Read maore

Services

# 1andsat download: OK

# ASTER, and MODIS download: OK
- . .

R *Fl‘ﬂ Classification

HAF

4

Layers
« &% T 2
v ® Sampled Points
v | | Buffered
® Reprojected
@ Boreholes
v [_] 5ub_locations
+ v I Population.tif
Mo
139960

- 5" Flavation.tif

e Open the Processing toolbox and search for Zonal Statistics
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Processing Toolbox
® A4 0O 2 B

. zonal statistics
v G) Recently used

Zonal statistics

~ (2 Raster analysis

ﬁ% Raster layer zg Algorithm I1D:
4 Zonal histogra ‘qgis:zonalstatistics'

¥s Zonal statistics
v @ GRASS
¥ Raster (r.%)
@ r.stats.zonal
v & SAGA
¥ QGeostatistics

@ Zonal multiple regression analysis (points and predict

@ Zonal raster statistics

e Double click on Zonal Statistics
e For Raster Layer select Population[EPSG:4326, for Vector Layer Containing Zones

select Buffered[EPSG:32737]
e Click Run

Q Zonal Statistics

Parameters Log

Raster layer

:l' Population.tif [EPSG:4326]

Raster band

Band 1 (Gray)

Vector layer containing zones
(9 Buffered [EPSG:32637]
Output column prefix
Statistics to calculate

1 options selected

0%

Run as Batch Process...

Zonal statistics

This algorithm calculates statistics
of a raster layer for each feature of
an overlapping polygon vector
layer.

Cancel

Run Close Help
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e After running the tool, a new column is added to the attribute tables of the Buffered

layer for the SUM of people in the 1km buffer.

() Buffered — Features Total: 34, Filtered: 34, Selected: 0 — X
/ =, € L TES D P = g
Boreholeld Status X Y _sum A =

1 13 Operational 38.6674407221... 1.06766218342... 1628.22103881...

2 12 Operational 38.6674407221... 1.06766218342... 1628.22103881...

3 11 Operational 38.6764296550... 1.05861517711... 665.516052246...

4 3 Not operational ~ 38.7406797545... 1.21626489120... 109.645910263...

5 10 Operational 38.6737294176... 1.09480676631... 84.6546649932...

6 17 Not operational ~ 39.1157744960... 1.02265475037... 84.6208820343...

7 33 Not operational  38.6225019939... 1.05860904084... 81.6983222961...

8 32 Not operational ~ 38.5685819794.. 1.00431479743.. 47.9866037368..

9 26 Not operational  39.0882386956... 1.14114056569... 43.6885547637...

10 25 Not operational ~ 39.0882386956... 1.14114056569... 43.6885547637...

? Show All Features.,.

e The values appear with decimal places since the population raster was encoded using the

floating point data type. These can be converted easily to integers by creating a new field
and assigning integer values of the _sum. Using the statistics tool, the sum of population
in the buffer was approximately 4880.

(=} Buffered — Features Total: 34, Filtered: 34, Selected: 0 — O >

4] g L T E @D P E = (-]
Boreholeld Status X Y _sum Population

1 10| Operational 38.6737294176... 1.09480676631... 84.6546649932...

2 17 Not operational ~ 39.1157744960... 1.02265475037... 84.6208820343...

3 33 Not operational  38.6225019939... 1.05860904084... 81.6983222961...

4 23 Not operational ~ 38.9709315652... 1.14903173253... 8.23799121379...

5 6 Not operational ~ 38.6584086889... 1.41148303862... 7.65894460678...

6 11 Operational 38.6764296550... 1.05861517711... 665516052246..

7 32 Not operational  38.5685819794._. 1.00431479743... 47.9866037368...

8 26 Not operational ~ 39.0882386956... 1.14114056569... 43.6885547637...

9 25 Not operational ~ 39.0882386956... 1.14114056569... 43.6885547637...

10 29 Operational 39.0972267821... 1.13331366821... 43.5979924201...

o ? Show All Features,,
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In this section we have learnt how to extract the number of people in a particular polygon from
a population raster. For instance we have created a 1 Km buffer around the boreholes and
determined the number of people living within the 1 Km radius.

e Close the attribute table, save the project
e Start a new project

4.9 Land Use/ Land Cover
We are going to add a land cover map and clip using our area of study map so that we can view
the land cover of the study area.

Land cover data files are usually in Raster format. When adding land cover data in raster format
use the procedure for adding Raster files that we learnt earlier on.

e Click on Layer 2Add Layers 2Add Raster Layers...

IE\Ed Settings Plugins Vector Raster Database Web Mesh SCP  Processing Help

% Data Source Manager Ctrl+L I i N Ly BT @y
Create Layer 4 o @SB A
A aye VS Add Vector Layer... Ctrl+Shift+V
Embed Layers and Groups... A ‘
Add from Layer Definition File... Eg Add Mesh Layer...
s Chiln 9 AdA Nalimitad Tavt | avar
e On the new dialogue use the "™ button to navigate to the folder with Landcover and
click open

e Once open select Landcover.tif Click Open, on the new dialogue window click Add then
Close the dialogue window
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—
| Q Open GDAL Supported Raster Dataset(s)

_J 3D Objects
I Desktop
Documents
¥ Downloads
Jﬁ Music

&=/ Pictures

ﬁ Videos

505 ()

« T « Raster » Landcover v D
Organize ~ New folder
Write_up A Name
@ OneDrive “X ESACCI-LC_S2_Prototype ColorLegend
. =%/ Landcover.tif
= This PC

'S symbology layer

File name: |Landcover.tif ~

£ Search Landcover
=- M @
Date modified

9/9/2020 11:06 AM
9/24/2020 3:32 PM
9/9/2020 11:32 AM

All files R

Open Cancel

e The layer is added to the map canvas. It should appear similar to the one below.

8l|Page



G- £
Browser a®
O2THe
Favorites

L Spatial Bookmarks
» [&] Home
)

@ GeoPackage

ﬁ SpatiaLite

@ rostGis

P mssal

@ Oracle

2 pa2

€9 WMS/WMTS

HH Viartar Tilac b
q »

Layers @&
« [ % T 2 = )

~ v B Landcover.tif
]
10

Now we are going to clipping the layer using our study Area;

e Add the following layers to the canvas Area_of_study.shp, and Sub_locations.shp. Remember
we used them previously, they are both Vector data files.

IEVE] Settings Plugins Vector Raster Database Web Mesh SCP  Processing Help

1 1! Data Source Manager Ctrl+L

Create Layer

e

Add Layer
Embed Layers and Groups...
Add from Layer Definition File...
Bl Copy Style
e Once added they should appear as below
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Ctrl+Shift+V
Ctrl+Shift+R

" Add Vector Layer...

'D Add Raster Layer...

B2 Add Mesh Layer...

95 Add Delimited Text Layer...



N8R~ £
Browser =L
O2vT®e

Favorites

» |m Spatial Bookmarks
» [ Home
y O

@ GeoPackage

ﬁSpatiaLite

@ rostals

P mssaL

@ Oracle

3 s>

£H WMS/WMTS

BE vartar Tilac
4 »

Layers @ ®
« il & T &~ & B O
V! [l Sub_locations
v Area_of study
+ /| &= Landcover.tif
||
10

e The next step is extracting the land cover within the Area of study.
e Open the Processing toolbox and on the search box type Clip raster by Mask

Processing Toolbox ®
B A4 0O E N

2 Clip raster by mask a
v &% GDAL

¥ Raster extraction

EI Clip raster by mask layer

e Click to Open the tool for Input layer select Landcover[EPSG:4326] for Mask layer select
Area_of_study[EPSG:4326] then click Run
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I Clip Raster by Mask Layer X

Parameters Log

Input layer A
8" Landcover.tif [EPSG:4326] v

Mask layer

(2 Area_of _study [EPSG:4326] v €9 % -

Selected features only

Source CRS [optional]

Target CRS [optional]

Assign a specified nodata value to output bands [optional]

Not set
Create an output alpha band

+/| Match the extent of the clipped raster to the extent of the mask layer
Keep resolution of input raster

Set output file resolution

X Resolution to output bands [optional]

Not set =

0% Cancel

Run as Batch Process... Run Close Help

e The land cover layer is clipped and a new land cover layer clipped to the study area is
added to the map. It is named Clipped (mask).

Layers & ®
¢ 8l &% T i B A
v v ¥ dipped (mask) &
||
8
V! Il sub locations
vl Area_of study
v V' i Landcover.tif
| K
10

e Before we apply a different symbology we need to hide all (turning off) the other layers
except Clipped (mask). To do this uncheck the box before each layer.
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Layers @ ®
o 1@ % T B & 0l

v v ¥ dipped (mask) €
[N
8

. Sub _locations
D Area_of study
v ¥ | andcover.tif
[
10

e On the map we can see only the clipped (mask) layer is visible
Browser @®
ORTHO
Favorites
» [P Spatial Bookmarks
» [&] Home
» DO
@ GeoPackage
ﬁ Spatialite
@ rostais
P mssal
@ Oracle
2 pe2
& WMs/WMTS
Bl Vector Tiles

Layers @®
o [ % T |E e

v v ¥ Clipped (mask) =]
[ K
8
. Sub locations
D Area_of study
v ¥ Landcover.tif
[ K
10

e The next step is to change the symbology of the layer in order to show the land cover
classes better.
e Double Click on Clipped(Mask) layer-> Properties
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RS WAL

Set CRS
Layers

B & T o vEHL
B Sub_locations Styles

W Area of study Properties...
Clipped (mask)

M
10

Export »

e Go to symbology, on the lower left corner click on Style, Load style...
() Layer Properties - Clipped (mask) | Symbology X

Q -

¥ Band Rendering

@ Information

Render type |Multiband color -
{Q Source
Red band Band 1 (Gray) -
& Symbology
Min |1 Max 10
L@ Transparency
Green band | Not set -
= Histogram
’ Min Max
4 Rendering
Blue band Not set -
@& Pyramids
. Min Max
a Metadata
Cortioct No enhancement -
Legend enhancement

I QGIS Server » Min [ Max Value Settings

v Color Rendering

Blending mode |Normal ¥ 49 Reset
Roighing 0o = [ Contrast e | 0 =
Load Style... [

0 |+  Grayscale Off -
Save Style... I = &

L 4 0,
Save as Default Strength ) [100%] -
Restore Default
Add...
r v out MNearest neighbour ¥ = Oversampling 2.00 |5
Rename Current...
V| default bnail Leaend Palette b
‘ Style v| oK Cancel Apply Help

e Onthe new dialogue window that appears select Symbology_layer from the raster folder
then click Open
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Q@ Layer Properties - Clipped (mask) | Symbo

(@ Load layer properties from style file

T « Raster » Kenya_Sentinel2_LUL...

Organize ~ New folder

~
= This PC Name

_J 3D Objects %] symbology layer

I Desktop
Documents
¥ Downloads
15 Music

[=] Pictures
E Videos
£305(C)

W& Notwerl <

v 0

Search Kenya_Sentinel2_LULC2... P

X

m ®

Date modified

9/9/2020 11:32 AM

File name: |Symbology_layer

e | QGIS Layer Style File (*.qml)

Cancel

Reset

-
-

TTSTTF]

-
o E

[100%][~

Style ~

Zoomed: in | Nearest neighbour ~

Thumbnail

out Nearest neighbour ~

Leaend

Palette

| ok

Oversampling | 2.00 %

Cancel

Apply

e Click Apply to render/Apply the symbology to the Clipped (Mask) Layer.
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Q Layer Properties - Clipped (mask) | Symbology X

Q,

v Band Rendering

@ Information

Render type Multiband color v
:{:\_‘ Source
Band Band 1 (Gray) v
& Ssymbology
Color ramp Random colors v
|J_i Transparency
Value Color Label =
= Histogram
«}" Rendering 1 . Tree Cover Areas
E& Pyramids
E Metadata 2 Shrublands
Legend
QGIS Server 3 Grasslands
a el .
Classify B | | = Delete All o

v Color Rendering

Blending mode | Normal - 4 Reset
Brightness _71 0 : [ Contrast _71 0 :
Saturation —— | 0 > [ Grayscale | Off -

Hue Colorize Strength —_| 100% |+

Style ~ OK Cancel Apply Help

e Click OK
e The Symbology of the layer changes, similarly the legend changes.

Browser BE
- g
5 Favorites
v 1" Spatial Bookmarks . 7 "
» [&] Home [
y e b '
Layers (@] =
c B ®TovBAL -
Clipped (mask) E - .
. Tree Cover Areas i
Shrublands
Grasslands

Cropland
[ | Aquatic Vegetation
Lichen Moses
Bare Areas
M Built up Areas
B Wetlands
. Sub locations
D Area_of study
- B Landcover.tif
|}
10

e To explore more, add the boreholes layer to understand their distribution within the
land cover classes
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FPHEEEE - A0 LPHEEEE Dist 0.010000|% | Min 60 2| Max 100 |+ | © [OIEETE To +/s200
Browser Bx
LeveHe
Favorites
» [ Home
r Do
& GeoPackage
ﬁSpatiaLi‘[e

@ rostals

™ mssn %
Layers =1Es]
¢ 0l % T &~ ft0

D Sub _locations
. Area_of study
v @ Area_boreholes
* V| = Clipped (mask)
M Tree Cover Areas
Shrublands
Grasslands
Cropland
[ | Aquatic Vegetation
Lichen Moses
Bare Areas
M Built up Areas
M wetlands
- ¥ Kenya Sentinel2 LULC2016
[ B
10

We can see that majority of the boreholes are within the tree cover Areas.

In this section we were able to extract part of a raster using a mask which is a vector, applied
different symbology to classify land cover classes, created an overlay of Land cover and boreholes
enabling us to identify their distribution in the study area.

Kudos, you have made a land cover map of the study area.

4.10 Population per land cover
In this section we will determine how many people are based within each land cover class. To
achieve this we will Use the population Raster and extract the sum value for each Land cover.

e Add Populations raster to the map, the raster is named Population.tif
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! Open GDAL Supported Raster Dataset(s) X |

&~ v 1 « QGIS_Training_data » Raster v (9] O Search Raster

Organize ~ New folder L= (7]

¥ Downloads A —

\ _ l -

= Documents |
/f l.

= Pictures

Cs0

My_Pics Elevation Landcover dist_water_ways Population.tif

Working_with_ra:
Write_up

@ OneDrive

4 This PC
J 3D Objects
I Desktop

File name: |Population.tif v ‘ All files v

Open Cancel

e The map appears similar to the one below. (Zoom to layer if need be)

Browser
BT O
tavarites
» [ Spatial Bookmarks
b |G Home
4 [} b
Layers
CIE R TR - ]
* v ¥ Population.tif
| i
139960
v «/ ¥ Clipped (mask) ==
M Tree Cover Areas
Shrublands
Grasslands
Cropland
Aquatic Vegetation
Lichen Moses
Bare Areas
M Guilt up Areas
W Wetlands
B sub_locations
: |;ln>rr of study
- = Landcover.tif
| B

10

e The next step is to calculate the sum of people per land cover class using Zonal statistics
e Open the processing tool, search and open Raster Layer Zonal Statistics.
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| @ Zonal statistics

*+© Recently used

Raster layer zonal statistics

v (@ Raster analysis

% Raster layer zonal statistics

'Z Zonal statistics

I Fmal Rictmrnen
e Click and open the tool, input the parameters as they appear in the following snip.

| Q Raster Layer Zonal Statistics

X

Parameters ‘ Log Raster layer zonal
Input layer statistics
| :l' Population.tif [EP5G:4326] hd | |_| This algorithm calculates statistics
for a raster layer's values,
Band number categorized by zones defined in
'Band 1 (Gray) - | another raster layer.
Zones laver If the reference layer parameter is
Y set to "Input layer”, then zones are
Clipned (mask) [EPSG:4326 v || ... || |determined by sampling the zone
| ¥ Clipped ( Ul ] | — | |raster layer value at the centroid
Zones band number of each pixel from the source
raster layer.
|Band 1 (Gray) v |
If the reference layer parameter is
v Advanced Parameters set to "Zones layer”, then the input
raster layer will be sampled at the
Reference layer centroid of each pixel from the
zones raster layer.
|Input layer v |
If either the source raster layer or
Statisti the zone raster layer value is
T NODATA for a pixel, that pixel's
|[Create temporary layer] | | __'| }falue ‘_mll _be skipped and not
including in the calculated
v/ | Open output file after running algorithm statistics.
| 0% | Cancel
|Run as Batch Pml:ess...| | Run | | Close | | Help |

e Click Run
e The output of this tool is a sheet names Statistics with counts, sum and more statistics
on the populations in the land cover classes.
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Layers
‘-( m L 4 Y 8.] b

B®
£ 3= g

v W ¥ Population.tif
Mo

9960

Area_Boreholes

v | i Clipped (mask) (]

. Tree Co

ver Areas

Shrublands
Grasslands

Cropland
[ | Aquatic Vegetation
Lichen Moses

Bare Ar

eas

M Built up Areas

B Wetlands

. Sub locations

D Area of study
v I Landcover.tif

[ K
10

e Right Click on Statistics > Open Attribute Table
v V¥ Population.tif
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Mo
139960
EE Statistics
v @ Area Bore

v ' = Clipped (m Copy Layer

M Tree Cover Rename Layer
Shrublands| (] Duplicate Layer
Grasslands L Remove Layer...
Cropland

M Aquatic veg ~ Moveto Top
Lichen Mos Move to Bottom

B Open Attribute Table
Bare Areas B==Ng| Attrit Tab!
= ﬁ;:aunpdi:\re f Toggle Editing

B sub locatic Filter...

D Area of stt

v B Landcover,

| N
10

Q Type to locate (Ctrl+

| i |
Show Feature Count

Change Data Source...

Make Permanent...

Export 4
Styles ’
Properties...




e The attribute table has a column for sum indicating the sum of people per land cover
classes. *The name of the land cover class is not included in the table, however the table
is arranged in the order of item occurrence in the legend*.

o0 Statistics = Features Total: 9, Filtered: 9, Selected: 0 — O
<] & - T E &L B S ee
zone deg? sum count min max mean
1 7.00000000: 0.02040873 15914.25029927 595118 0.00063166 6.79236603 0.02674134
2 1.00000000 0.03630112 69155.53024771 1058540 0.00062308 6.40263510 0.06533105
3 8.00000000 0.00006341  7681.65114956 1849 0.08927021 6.82571268 4.15448953
4 3.00000000 0.25705965 239998.627950... 7495854 0.00062308 6.82571268 0.03201752
5 4.00000000 0.00614730 13223.36428316 179255 0.00067762 6.79236603 0.07376845
6 10.00000000 0.00001814 2147037877 529 0.00130322 0.35725757 0.04058673
7 6.00000000 0.00007150 94.85786161 2085 0.00244024 412750292 0.04549538
8 5.00000000 0.00018659  218.09038540 5441 0.00087661 6.17552471 0.04008278
9 2.00000000 0.38454311 361641.952426... 11213269 0.00062708 6.74600649 0.03225125

After viewing close the attribute table and save the project.

We have successfully calculated the sum of people living on each land cover class in the study
area. The difference of this statistics from the previous is that we have used raster for input and
Zones layer, unlike earlier where we used a vector layer for zones input.

Summary

In this section we have worked with raster datasets. We have learnt how to add raster data to
our map canvas, how to change or symbolize raster layers as well as done some basic spatial
analysis using raster layers. We have used Zonal statistics tool to extract values such as average
elevation of sub location, borehole elevation and also population per land cover class.
Additionally, we have learnt how to clip a raster using the extract by mask tool.

Next we are going to style and output a printable map document.

5. Styling and map design
Presentation of the results of any spatial analysis is as important as the analysis itself. Mostly,
Outputs from a spatial analysis include Maps followed by charts. In this section we are going to
style and design a simple map. The features that need to appear clear in the map include;
Boreholes, Land cover and Sub locations.

5.1 Preparing data for mapping
Before designing a map of interest, it is important to choose the right symbology and names for
your data.

e Inthe map, turn off or remove all layers except the layers shown in the snippet below
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v
v
\'4
v

© Boreholes

|:| Sub_locations

. Area_of study

" Landcover.tif

B Tree Cover Areas
Shrublands
Grasslands

Cropland
- Annatic Venetatinn

e Right click on Sub_locations = Properties = Symbology
e Click on Simple Fill 2 Fill style set to No brush. Click Apply then Okay

(23 Layer Properties — Sub_locations — Symbology X

€ Labels
€O Masks

NF 3D View

- .
b Diagrams

E Fields

Attributes
Form

Joins

L Auxiliary
=
&N Storage

,@ Actions
, Display

/ .
4 Rendering

a Temporal

Variables

a Metadata

ﬁ Dependenci g

E Single symbol

~ I Fill &
[ simple fill
£ a3
Symbol layer type Simple fill -
Fill color MEEE
Fill style B solid > | €
stroke color [ - <.
Stroke width  0.260000 @ 2| | Millimeters hd @'
Stroke style Solid Line > | €
Join style T Bevel > | €
x | 0.000000 =
Offset — Millimeters -
y | 0.000000 =
v/ | Enable symbol layer ﬁ Draw effects
b Layer Rendering
Style OK Cancel Apply Help

o

e This removes the fill color and only boundaries are left

94| Page



¢ v (G Raster analysis
i Raster layer statistics
4 Raster layer unigque values report
¥ Raster layer zonal statistics
A% Zonal histogram
HF Zonal statistics
= @ Vector analysis
. Basic statistics for fields

44

SEHSBHMAEANENS

4

SchRad: E Statistics by categories
SCP Version 6.4.7 - Greenbelt v QWM
#“Z4E>A@S = o
i w 2 Extract M values
 Plugin L % Extract 2 vahoes
*Sﬂ!mmﬂm - @GR}\SS
update QGIS to version 3.14.16 ~ Imagery (4
Head more
# Developing the new Semi- @ igersig
 Automatic Classification Plugin 7 L
| Head more

£ Suppost the SC8

o We will repeat the same procedure for the Area_of_study layer

e Click on Area_of _study >Properties 2> Symbology

e Click on Simple fill>Fill style select No Brush

o Click Apply then OK

e The canvas should appear similar to the one below

e You can also use Properties = Source to change the name of each data layer, for instance
Sub_locations to Sub-location and and Landcover.tif to Landcover
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Browser
zEeTre
1 Favorites
v 1% spatial Bookmarks
v [&] Home
[l s
6 GeoPackage
# spatialite
W rostols
B msscn
@ oracle
& pe2
B WS WMTS
B Vector Ties
v B V2 Tiles
& wes
WIS / OGC API - Features
© ows
@ ArcGIS Map Senvice
& AreGIS Feature Service
¢ GeoNode

S|

L

SHBSABNEN

Layers.

“fANT RO
v © Boreholes
[ Area_of study
v Sublocations

Tres Cover Areas

I Shrublands

I Grasslands

B Cropland

I Aquatic Vegetation
Lichen Moses
Bare Areas

W it up Aseas

W wetlands

| 2 Typeto locate (ri+K)_ 1 legend entries remaved.

E Basic statistics for fields
= (3 Raster analysis
A Rastes layar statistics
3 Raster layer unique vahses report
¥ Rastes layer zoral statistics
 Zomal histogram
3 Zonal statistics
= (@ Vector analysis
I Basic statistics for fields

anm_msmi%.he@mmg ~ @ Mogufler 100% 3 Rtaon 0.0° 3|V Render MEvscaize @

e Label the sub locations layer, *Using the procedure illustrated earlier in the tutorial*.

5.2 Prepare a map layout
A map layout is where you design your map by placing all the important map elements. The elements

include the map data, legends, north arrow etc.

e To create a printable map we need to create a new print layout.
e Click on Projects = New Print Layout...
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Edit View Layer Settings Plugins Vec
[ New Ctrl+N E

New from Template »

Open... Ctrl+O
Open From 4 '
Open Recent 4
Close

Save Ctrl+S

=l Save As... Ctrl+Shift+S
Save To 4
Revert...
Properties... Ctrl+Shift+P

L Snapping Options...

Import/Export 4

A New Print Layout... Ctrl+P
@ New Report...
@ Layout Manager...

I Layouts »
Exit QGIS Ctrl+Q

e Choose a name, here we’ve typed Boreholes, then click OK

(2 Create print layout Title X

Enter a unique print layout title
(a title will be automatically generated if left empty)

\BOREHOLES] |

OK | Cancel

e A new print layout opens.
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@ *BOREHOLES
Layout Edit View [tems Add Item Atlas Settings

BRREER b ®kkhkk i
PLANR BRAWHEE

EoL i O P R

2. bbb Bl

150

TN TS B 108 1
=]

ddHEwRE2Te
24 Bveon

}
;:o[ 5

s

[250

Click on Add Item Add Map
(2 *BOREHOLES

Layout Edit WView
RLRE B
pLpopRHRHE @

izl Add Item

21 Add 3D Map

x: 333.693 mm y: 179.681 mm page: 1

Atlas Settings
IR Add Map

300

Items  Undo History
Undo History
<emply>

Layout Item Properties
Item Properties

46.7%

Draw a rectangle on the canvas of the layout, where the map is rendered.

Guides

@3

-5




e The map is rendered inside the rectangle.

S0

100

150

200
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e Inthe map, draw a box where a legend should be added

e Onthe tab before Legend Items Input the title as Legend
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Next we add the legend, click Add Item, Add Legend

Jite[sRiTIgY Atlas Settings

' Add Map
74 Add 3D Map
2 Add Picture
Add Label

+ Add Legend
Add Scale Bar
3 Add Shape
Add Arrow
Add Node Item
Add HTML
Add Attribute Ta

ble

J =]

© Boreholes
[ Area_of_study
[ ] Sublocations
Landcover
B Tree Cover Areas
[ shrublands
:- Grasslands
[ Cropland
[ Aquatic Vegetation
[ ] Lichen Moses
[ Bare Areas
I Built up Areas

‘- We'darrnglis




Legend

v Main Properties

Title Legend €
Title alignment | Left v
Map Map 1 v
Wrap text on

+/| Resize to fit contents
v Legend Items

Auto update Update All

D Sub_locations =
— PR |

4 »

e The legend has some unnecessary layer, to remove them navigate to the right

Legend Items and uncheck Auto Update

v Legend Items

to update Update All

© Boreholes -
D Area_of study
: Sublocations
v = Landcover
B Tree Cover Areas
Shrublands
Grasslands
Cropland
[ ] Aquatic Vegetation

=

e To edit the names of the layers such as Sub_locations to Sub-locations double click

on the layer name, in the dialogue box that appears input the desired name.
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300 ‘ ‘

Items Undo History
ltems B ®
ON ; Item
T| Borehole Location Map
== <Scalebar>
i~ Legend
Map 1

LLL L

Layout Item Properties Guides

ltem Properties ®
Legend
Title Legend L S PN
Title alignment | Left v
Map Map 1 v
Wrap text on
B v/ | Resize to fit contents
A
(d Legend Ite... X egend Ttems
Item text Auto update Update All
Sub-locations| [ i a
0K Cancel D Area_of study
@ Area boreholes
-
v " Clinned (macld 4
y >
e Click OK to save the name. Repeat the procedure for all names which require to be

changed
e The next step is to add scale and Title

e Click on Add Item - Scale bar
e Onthe Canvas, draw a box above the legend where the scale should be rendered
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© Boreholes
(] Area_of_study
| Sublocations
Landcover
B Tree Cover Areas
] Shrublands
[ ] Grasslands
[ Cropland
I Aquatic Vegetation
___] Lichen Moses
| Bare Areas
B Built up Areas
B Wetlands

e Now the scale bar has been added to the map

e To add Map Title, Select Add Item—> Add Label
JGe[s NIzl Atlas  Settings
'3 Add Map k
| £ Add 3D Map
| B8 Add Picture —
Add Label

£, Add Legend

Add Scale Bar

2 Add Shape

Add Arrow

Add Node ltem

Add HTML

Add Attribute Table
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Draw a box above the Map, on the far left inside the Tab labeled Main Properties, delete
Loren Ipsum and Type Borehole Location Map, scroll down and in Horizontal alignment
check the circle labeled center. For Vertical Alignment check the circle next to Bottom.

Now the Title is Centered

I u - I [ ]

1 ] O
7 Map of Boreholes and Landcover Classes -
1 [ [}
- @]
[ |
_ - | | O
[ |
|
. L
[ |
O n

We can also add a North Arrow using Add Item > North Arrow
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Map of Boreholes and Landcover Classes

0 210 o4 20 km
I

@ Boreholes

3 Area_of_study
| Sublocations
Landcover

B Tree Cover Areas
] Shrublands

[ ] Grasslands

] Cropland
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5.3 Export the map

Map of Boreholes and Landcover Classes
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e At this point the map is ready for export.

e Click on Layout there are options for export, as Image SVG or PDF.
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GG Edit View ltems Add ltem  Atlas

Setting:

Save Project
New Layout...
Duplicate Layout...
{J Delete Layout...
Layout Manager...
Layouts
Layout Properties...
Rename Layout...
[ ¢ Add Pages...
Add Items from Template...
Save as Template...

EE; Export as 5VG...
@; Export as PDF...
Page Setup...

& Print...

Close

Ctrl+S
Ctrl+N

=
=& Export as Image...

Ctrl+Shift+P

Ctrl+P
Ctrl+Q

e Click Export as Image... In the dialogue box that appears select a folder where you

want to save your map, Click Save. Your map is saved and ready for use.

Q Image Export Options

v Export Options

Export resolution |300 dpi =
Page width 3507 px o
Page height 2480 px =

v/ Enable antialiasing
Generate world file
v Crop to Content

Top margin (px) |0
Left 0 Right

Bottom 0

| Save

Cancel

X

In the saved map remove the outer white spaces by Clipping.
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6. Conclusion

In this exercise, you performed various GIS steps to assess access to water in the northern areas of Isiolo
County of Kenya. This exercise was meant to introduce the participant to vector and raster data models
which are the common data structures in GIS. In this task, you used both Vector (boundary of the study
areas, Sub locations, and borehole) and Raster (Elevation, Population, Distance to Water and Land cover)
data. We managed to add both vector and raster data and use them for analysis in QGIS. You also managed
to execute different GIS operations on the vector and raster data. Specific operations included clipping,
guerying attribute tables, spatial join, buffering and point in polygon analysis. For raster data, you were
able to add, extracting layer by mask, apply different layer symbology and implement zonal statistics.

Finally, you were able to style and design a map from the data.

In the hypothetical example of access to water resources, you were able to determine the average
distance to water ways from each borehole. You were also able to estimate the average population and
elevation in each sub-location. Here, we used QGIS which is an open source and free GIS software, the
standard procedures in this system are to a large extent similar to those in other tools. It is our hope that
this basic level module allowed the participant to learn basic GIS concepts and their application in a typical

GIS tool.
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